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Fig.1-1: Père-Lachaise cemetery in Paris – virtual tour with interactive map [2] 

1. Introduction 
 
 With the sophistication of the Internet and multimedia technology comes the ability to 
view panoramic images in a more interactive way. With these technologies the audience can 
spin the panorama to experience the environment in much the same way as if they were 
“actually there”. Someone once said that the difference between conventional and panoramic 
photography is like the difference between looking at a city from a small office window and 
from a rooftop.  

Panoguide.com [1] presents on its webpage a brief guide how to make a virtual tour. 
At first one needs some panoramas. Techniques of making panoramas are discussed in this 
diploma thesis. Before designing a virtual tour one should decide what kind of object or place 
will be presented. There are plenty of software and file formats for making panoramas. These 
panoramas should be linked each other to make a simple virtual tour. This linker is called hot 
spot and it is a part of panorama image when one clicks on it then something happens. The 
most common example of this is a hot spot over a doorway in a panorama – when clicked on, 
appears a new panorama showing what the room the other side of the door looks like. 
Knowledge of HTML or XML is necessary to edit files with hot spots in some software for 
virtual tours.  There also exists programs with a good tutorial and knowledge of coding 
languages is not necessary but really helps to control designing a virtual tour. The advantage 
of these programs is that you have good results in a short time. There are many kinds of 
interactive viewers that can present panoramas with coded hot spot’s file. Some of them are 
based on Java, others want you to install extra plug-in to your browser. There are also stand-
alone viewers which do not need extra plug-ins or Java.  

 To make a virtual tour livelier it is good to add some sound, movies etc. In general we 
can say that the more interactive virtual tours are, the more time a user spends on watching it. 
Travel and estate agents have quickly seen the potential of interactive websites to advertise 
their holidays and properties, and now it is common to take virtual tour around many different 
places (even a cemetery (Fig.1-1)) without even leave the glare of the computer screen. 

 

 

 
 What is more in order to have a completely “immersive” experience, one needs to 

consider spherical panoramic photography. A technique for making spherical panoramas 
using a few methods is described in this diploma thesis. Especially the one with a digital 
panoramic camera and fisheye lens is described in details. 
 Panoramas have an amazing effect, whether integrated in a personal homepage or 
professionally used in architecture, in museums, in company or product presentations. A great 
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example of such interactive and multi-node virtual tour with well-presented map and tour 
interface is a website of The Sydney Opera House (Fig.1-2). Viewers know where they are in 
the tour at any given time. One can view different floors and rooms ranging from the main 
concert hall to the place for cars.  

 

 

  
 One of the targets of photogrammetry is to change the real world to the virtual one. 
This virtual world could be then presented not only on the computer screen, but also in print 
version. Computer’s version gives the user many opportunities to decide where to go, which 
place to see or which video to watch. There are two kinds of virtual tours. One of them is 
three dimensional with a great help of photogrammetry. Photographs are projected on surfaces 
of walls, buildings, floors of buildings, museums etc. Receiving a 3D model of the place of 
interest is not only a task of photogrammetry but also surveying. Second kind of virtual tours 
is a presentation that uses a panoramic imagery. This type of virtual tour was designed and 
described in this diploma thesis.  
 Virtual museums could offer a way of travelling back in time to experience the past. 
The researchers say the technology could give visitors to a virtual museum a sense of “being 
there”. For example the team from the University of Geneva has developed virtual reality 
models of two Turkish mosques dating from the Ottoman era of the 16th century which let you 
move around and explore the buildings in real time [4]. The researchers are now performing 
these demonstrations in 3D stereo on a big screen. They say that you feel like you are in the 
building. In this kind of virtual museum one moves without “jumping” in the space. The other 
types of museums are these with panoramic images, in which one “jumps” through space to 
get to another panoramic image.  
 This diploma thesis introduces the production of cylindrical and spherical panoramas 
and explains how to link individual panoramas to make a virtual tour. The designing process 
of the virtual tour of the Dresden University of Technology campus is explained in this work. 
The author spent his fifth year of his studies (1.10.2004 - 30.06.2005) at the Dresden 
University of Technology in Germany. 
 In the second chapter there is a description of the Dresden University of Technology 
and its campus. A map of the campus that was used in SPi-V viewer is showing 53 hot spots 

Fig.1-2: Multi-node panoramic experience of the Sydney Opera House website [3] 
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of panoramas generated during the project (Fig. 2-3). The third chapter is about spherical and 
cylindrical panoramas. At first there is a history of panoramic photography and projections 
types. Three types of cameras and three types of taking panoramic images are described on 
the example of flatback, swinglens and rotational cameras. What is more digital technology of 
rotational cameras is specified on the example of the digital panoramic camera that was used 
in the project – Eyescan MM1. This camera allows you to get a whole 360° panorama in less 
than one minute without stitching process. In this project there were used three different 
lenses. Differences in field of view are described in this chapter. The last part of the second 
chapter presents a process of taking a panorama using Eyescan MM1. Program IcaScan that 
controls the camera is described in details as well as some tips that are important and not 
written in the manual. Those tips are important for someone who starts working with this 
camera. They were noticed by the author during a registration of more than fifty panoramas. 
 After that there is a description of a practical part of this diploma thesis. Two methods 
of creating spherical panoramas are described in this place. One of them is creating spherical 
panorama using digital panoramic camera Eyescan MM1 and fisheye lens. The second 
method is working with two hemispherical images in order to get one spherical panorama. 
Editing panoramic images is the title of the forth chapter. It is a continuance of the practical 
part. Errors of lenses are also described in this diploma thesis. One of the most visible errors 
connecting with lenses (especially fisheye lens) is chromatic aberration. Knowing the 
parameters of the curve makes it possible to correct chromatic aberration in images. 
Unfortunately it was difficult to find such parameters even for conventional images. In 2004 
two scientists found a solution to determine the coefficients for correcting channels of three 
colours – red, green, and blue. The way how to determine coefficients for panoramic images 
had not been found before. This diploma thesis contains a description of a trial of finding the 
coefficients to the curve which corrects chromatic aberration in spherical panoramas that was 
produced using fisheye lens. Other solutions of editing panoramic images are presented in this 
chapter. Displaying panoramic images and virtual tours is the topic of next chapter. All 
panoramas are now edited and prepared for displaying. Before doing this a few things should 
be considered such as user interface, bandwidth and a kind of a viewer. In this project three 
different viewers were used. FSPViewer is a stand-alone viewer that works best in local hard 
disk. SPi-V is a plug-in viewer that needs an installation of Macromedia Shockwave Player 
but it has a high performance and quality. The last viewer that was tested in this diploma 
thesis is Java-based viewer and PanoramaVision – the editor for generation of virtual tours. 
Differences between these viewers are also included in the fifth chapter. Generation of a 
stereo panorama is presented in the next chapter. At first a few methods are shown. A new 
method was carried out and two stereo panoramic images were produced. These stereo 
panoramas were made in Cracow on Grodzka Street and Rose Avenue. A description of 
generation of panoramic images using a digital camera Nikon D50 is also presented on the 
example of program that is called PTGui where the stitching process was carried out. In the 
last part of this diploma thesis displaying panoramic images in Head Mounted Device is 
presented. Panoramic images and also stereo panoramic images were implemented into VFX1 
(virtual helmet). One of the most important features of this helmet is called head tracking and 
it recognizes movement of a head. This feature was used to spin while watching panorama. 
 The virtual tour of the Dresden University of Technology campus can be found in the 
Internet: www.kwiatek.krakow.pl/panotour. In order to view all interactive panoramas one 
will need to install proper plug-ins that are mentioned on the webpage. It is also possible that 
this Internet address will change so please refer to author’s webpage 
(www.kwiatek.krakow.pl) for a new link.  
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2. The Dresden University of Technology campus 
 
  
 The Dresden University of Technology (Technische Universität Dresden (TUD), 
Germany) with its buildings and facilities occupy an area of about 275 hectares [5]. The 
university was founded in 1828 as an Educational Establishment of Technology. The 
institution came to be officially acknowledged as Royal Saxon Polytechnic in 1871, and, in 
1890, obtained the status of College of Technology. Ten years later it was granted the right to 
confer doctorates. Many well-known scientists have contributed to the worldwide reputation 
of the university, for example: Johann Andreas Schubert (design engineer of the first German 
steam locomotive), Hubert Engels (founder of the world’s first permanent river-engineering 
laboratory), Kurt Beyer (bridge builder engineer) etc. All buildings in the campus have names 
that comes from well-knows scientists (Fig. 2-1). 
 

 

 As a natural consequence of this development, the college was given a name of a 
Technical University in 1961. The unification of Germany in 1990 marked the beginning of a 
new stage in the history of the Dresden University of Technology. Several faculties were 
added to the traditional faculties of sciences and engineering. These include: social sciences, 
transport and communication, law, and medicine. Now the university has 14 faculties with 
different departments and diverse courses of study. The faculty where one could study 
Photogrammetry is called Faculty of Forestry, Water Sciences and Geosciences and it is 
situated in Hülsse’s building (Fig. 2-2).   
 

 

Fig.2-1: Beyer’s building at the Dresden University of Technology campus. 

Fig.2-2: One frame of the animated GIF of Hülsee’s building  
at the Dresden University of Technology campus [6] 
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 At present, 24,000 students are studying at the Dresden University of Technology. 
Around 600 professors and 90 associate professors, along with members of the non-
professorial staff, are responsible for ensuring high standards of teaching and research. The 
academic year is divided into a winter semester and a summer semester, each extending over 
15 weeks, followed by examinations. Teaching covers basic courses (usually 4 terms) which 
lead to an intermediate diploma, and main courses or specialized studies with a final degree 
examination. 
 The following map of the TUD campus (Fig. 2-3) shows positions of 53 panoramas. 
Orange colour represents buildings that belong to the university. Some abbreviations are also 
shown in this map in order to help locating on this map. For example: BEY – Beyer’s 
building or ZEU – Zeuner’s building. Near Hülsee’s building there are a lot of panoramic 
images. Most of spherical panoramic images are placed there because of high buildings in this 
area. 
 

 

 
 More information about the university and Dresden can be found on: 

o The Dresden University of Science and Technology - www.tu-dresden.de 
o The Institute of Photogrammetry and Remote Sensing - www.tu-dresden.de/ipf/ 
o Dresden - www.dresden.de 

 
 
 
 
 
 
 
 
 
 

Fig.2-3: The map of the Dresden University of Technology campus 
 and 53 hot spots to panoramic images 
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3. Cylindrical and spherical panoramic images 
 
3.1. History 

 
According to Merriam-Webster’s dictionary [7], the word “panorama” is a 

combination of two Greek terms, namely the suffix pan ( ), meaning “all” and horama 
( ), meaning “sight”. The dictionary also listed the year of its conception. or start of 
popular usage as 1796. Robert Barker was arguably the first person who conceived the idea of 
the panorama. He had received a patent for it on 17th June 1767. The patent described an 
artistic format of paintings that practically surrounds the viewer. A panorama painter’s goal 
was to reproduce the real world so realistically that onlookers could believe that what they 
were seeing was real. It was only by the 1800s that the word “panorama” became part of the 
vocabulary of every European language. Since the mid-1850s there has been a fascination 
with panoramic photography – the production of images that make us feel like ‘we are there’. 
Ever before the term ‘virtual reality’ became an everyday part of our language, these wide-
angled vistas gave audiences the opportunity to experience places that they had never seen 
before. The idea was simple – to use the camera to duplicate what the viewer would see if he 
or she was actually standing in the same spot, or to show a view that extends beyond the 
viewer’s field of vision. The photographer could produce pictures that simulated what the 
viewer would experience if he or she moved his or her head from side to side. Unlike standard 
photography, which tends to focus on one aspect of a scene to the exclusion of other elements, 
panoramic imaging concerns itself with capturing all the detail of the world that surrounds us.  

Early pioneers made a series of separately exposed and processed daguerreotype plates 
side by side to form their images. Each image was carefully composed in the camera and the 
elements of the scene that fell at the edge of the frame noted. Once the exposure was taken, 
the camera was rotated so that the new composition was connected to the first, a new plate 
was installed and the second exposure was made. This process was repeated to produce a 
series of images which could be exhibited to form a panorama.  

 

 
Fig. 3.1-1: No. 3A Panoram Kodak swing lens panorama camera, made by Eastman Kodak 

Company, New York, USA, around 1928 [8] 

Swing lens 
mechanism 
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The same multiple-images technique was used with the ‘wet-plate’ process that followed the 
daguerreotype system. It was only in the late nineteenth century that camera manufactures 
began to produce equipment designed to specifically capture wide images. Engineered to 
eliminate the need to shoot multiple images, most units followed one of two designs: the 
swing lens or 360°. 

- swing lens: these cameras kept the film static whilst the lens moved from side to side 
on a pivot system.(Fig.3.1-1) 

- 360°: more complex in design, these cameras moved both film and lens around a 
central point through a full 360°, capturing the whole scene in a single movement. 

Both types of camera produced amazing images that, unlike the results from techniques used 
previously, covered whole vistas in a single picture. The 100 years subsequent to the release 
of these early models saw great improvements in lenses, camera bodies and film-transport 
mechanism, but the essential designs have remained the same. Modern film-based panoramic 
cameras are high-quality optical instruments capable of creating stunning images with masses 
of fine detail.  
 It would be fair to say that digital camera and imaging technology has turned many 
areas of photography upside down. In this new, silicon-based technology it is easy to 
manipulate and enhance our pictures. Digital camera users started to emulate their panoramic 
forefathers by shooting images of wide-angle scenes. Using the basic editing tools of the time 
the individual images were then placed side by side in a single digital document. More 
advanced users started shooting overlapping images and then blending the repeated edge 
elements of the image to form a seamless picture. The increasing sophistication of the 
manipulation tools in programs such as Photoshop made this complex task more achievable, 
but still time-consuming. It did not take long time before a range of companies started to 
produce specialist blending and stitching programs designed to simplify the whole 
construction process.   
 In 1995 a company Apple produced software which is called QuickTime VR. This 
program revolutionized the way viewing panoramas. It was possible to spin left or right 
around one point. By moving mouse it was possible to spin left or right or even all the whole 
vista. Today, when people think about panorama they refer to QuickTime version rather than 
to the print version. In 2001 QuickTime 5.0 was produced and it enabled users to make a 
cubic panoramas. In this kind of panoramic images it is possible to look not only left and right 
but also up and down.  
 Nowadays the most amazing development in virtual reality world is VR video. It is 
sometimes called ‘navigable movies’. This is a movie that allows you to turn left or right, or 
even behind to get a different perspective on the event. Please think how different could be 
watching movies when it is possible to move the viewpoint from the main actor to the 
reaction of the supporting cast during critical moments of the story. What is more, you can 
zoom in on different person of the band during the concert. This technology exists now and 
you can watch a few concert recorded with DV cameras and a special lens adaptor. Such 
concerts are available in the Internet or on DVD. Spincam was the first company in the world 
to include 360° video on a CD as well as being the first to release such footage on DVD. In 
2001 they made history again by broadcasting awards ceremony, the Brit Awards, live on the 
Internet in 360° video.  
 
3.2. Panoramic formats – projections type 
 
 Panoramas come in various shapes and sizes. In the process of creating a panorama it 
is important to choose a projection type. The word projection is used to describe how the 
perspective of panoramic pictures is changed by software in order to present a realistic display 
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of the panorama on a computer screen. According to Panotools.info [9] the format of a 
panorama is defined in broad terms by the projection used to map the full or partial 3D scene 
into a 2 dimensional print or screen. There are several types of projections that are used in the 
panoramic production process: 
 

A. Full spherical formats 
a. Equirectangular 
b. Cubic 

B. Partial formats  
a. Cylindrical 
b. Rectilinear 
c. Partial Spherical 

A. Full Spherical Formats  

Display the whole sphere that surrounds us – 360° along the horizon, 90° up and 90° 
down.  

a. Equirectangular – this format is widely used by viewers such as PTViewers 
and Spi-V. Aspect ratio must be exactly twice the height. (Fig.3.2-1) 

 

 

b. Cubic – this format uses 6 cube faces to make a full sphere that surround us. 
The image is remapped to the cubicfaces. The most popular viewer for this 
projection is QuickTime VR. (Fig.3.2-2) 

 

 

B. Partial Formats 

Here we can talk about panoramas that do not fill the whole sphere. Partial panoramas can 
be displayed directly if they do not cover more than approximately 120° along the shorter 
side (they can be 360° in one direction but must be 120° or less in the other direction). 
The main formats are cylindrical and rectilinear, but partial spherical panoramas are 
possible, too.  

Fig.3.2-1: Equirectangular panorama format [9] 

Fig.3.2-2: Cubic panorama format [9] 
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a. Cylindrical – this kind of projection can show a full circle along the horizon 
or a part of it. They are very popular for landscape panoramas. (Fig.3.2-3) 

 

 

b. Rectilinear – in this projection panoramas are displayed in the same way as 
non-fisheye lens would do. The horizontal and vertical field of view is limited 
to about 120°. Straight lines stay straight, hence they are good for architectural 
subjects. But if either field of view is too large they suffer from unnatural 
looking distortions in the corners. (Fig.3.2-4) 

 

 

c. Partial Spherical - applies basically the same as to full spherical (see 
above). In most cases they are used to cut off zenith or nadir. Vertical field of 
view has to be limited in this case to prevent the viewer from misinterpreting 
the source images. (Fig.3.2-5) 

 

 
On the second hand Philip Andrews [10] makes another easy to remember classification of 
projection types: 

- Flat 
- Planar 
- Cylindrical 
- Cubic 
- Spherical 

 
Flat 

This panoramic image is projected on a flat screen. The distortion that 
occurs as a result of using wide-angle lenses to capture source images is 
not corrected. Therefore some straight lines in the scene appear as 
curves in the image. 

Fig.3.2-3: Cubic panorama format [9] 

Fig.3.2-4: Rectilinear panorama format [9] 

Fig.3.2-5: Partial spherical panorama format [9] 
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Planar 
The panoramic image is rendered onto a flat screen so that no distortion 
occurs. 

 
Cylindrical 

The panoramic image is projected onto the inside of a cylinder. This 
type of projection is used mainly for single-row stitched panoramas. 
The option does not work particularly well if the source pictures are 
captured with spherical or fisheye lenses. 

 
Cubic 

The panoramic image is projected onto the inside six faces of a cube. 
The viewer reconstructs the six images so that it appears that you are 
standing inside a spherical representation of the environment.  

 
Spherical 

Like the cubic projection detailed above this option projects the 
panoramic image onto the inside of a sphere. But unlike cubic the 
results are stored as a single image rather than several faces of a cube. 

 
 
3.3. Ratios between panoramic width and height 
 
 Some projection formats or file types have specific requirements when it comes to the 
width and height of the image that can be converted to an interactive panorama. Table 3.3-1 
shows these ratios. 
 

Projection Ratio settings 

Cubic Width/length = 1 
Spherical Width/length = 2 
Cylindrical Width/length = 360° / viewing angle in degrees 
Cylindrical QTVR Height must be a multiple of 4 and width a multiple of 24 
Cubic QTVR Height and width must be a multiple of 2 
Cylindrical  Width must be a multiple of 2 
Spherical Height must be a multiple of 2 and width a multiple of 4 

 

Tab.3.3-1: A summary of the ratio settings that need to be used for 
 the following projections or file types. [10] 

 
 
3.4. Three types of camera, three ways to shoot 
 

Panoramic cameras were built to get a longer than normal aspect ratio. Their 
construction is designed to get enough amount of light on a film or digital sensor. Aspect 
ratios are very important consideration. They affect not only the final result of a panoramic 
image but also the whole means of capturing the light on film to create a panorama. That is 
why sometimes cameras have strange construction.  

What is more the style of shooting panoramas is also important. There are three 
different kinds of cameras according to this style. However they capture light and controls 
perspective in entirely different ways. It is essential to understand the differences between 
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Fig.3.4-1: Flatback camera [12] 

them, as their characteristics affect the way that panoramas are made and the way the finished 
photographs will look.  
 There are three categories of panoramic cameras [11]: 

·  flatback or straightback cameras 
·  swinglens or short rotation cameras 
·  full-rotation or slit-scan cameras 

 
3.4.1. Flatback cameras 
 

This type of cameras (Fig.3.4-1) has varying degrees of lenses projecting light onto a 
flat plane, using mainly wide-angle lenses. The optical effect of these cameras is similar to 
slicing a straight section through the centre of a larger film format. The aspect ratio of these 
cameras changes with the length of film. Flatback cameras are ideal if you need to shoot 
architectural pictures, across parallel lines. It is good to use these kinds of cameras when you 
need a lot of undistorted information across a wide area. The next advantage is that these 
cameras are easy to synchronise with flash lighting, because they are controlled by one-point 
shutter. There are a few examples of flatback cameras: Hasselblad X-Pan, Timiyama Art, 
Canham 4”x10”, Fuji GX617, Glide 66-17 MST, Linhof Technorama 617, Horseman SW612 
PRO and Z-Pan. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.4.2. Swinglens cameras 
 
 Swinglens, or short-rotation cameras (Fig.3.4-2) are constructed in different way. They 
enable a thin strip of light to scan across a curved film plane. The first panoramic images were 
built using this rule of constructing such cameras. The most popular and commonly seen 
cameras are the Noblex and Widelux. They scan from a point source across 140 degrees of 
view; they are most related to human vision. That is why they are the only representatives of 
‘true’ perspective. Mechanism of moving lens is often the weakest part of these cameras. In 
Widelux, there were many problems with getting up to speed from one side of the exposure to 
the other. These problems were fixed in Noblex, by designing a shutter that gets up to speed 
with a half rotation before it exposes any film to the light, which was much more successful 
solution. There are a few exaples of swinglens cameras: Noblex 135U, Noblex Pro 6/150, 
Widelux F8, Horizon 35mm, Widepan 120 Pro and Mottweiler ‘Pinoramic’. 
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Fig.3.4-2: Swinglens camera [12] 

Fig.3.4-3: Rotational camera [12] 

 
 
 
 
 
 
 
 
 
 
 
 

3.4.3. Rotational cameras 
 
 Rotational cameras (Fig.3.4-3) make 360° images. Some of them can make even more 
than 360°. They can also make a panorama of a before programmed angle, for example 30°, 
60°, 120°, 270° etc. They are mainly used in architectural and industrial photography. What is 
unique in these cameras is that they produce a very different perspective to any other type of 
camera. Straight lines become strangely curved. Some people say it is a distortion but others 
say that this is ‘true’ perspective. One can easily find cameras that use film and others are 
digital. For example Spheron Panocam 12FX – this is one of the high-resolution digital 
cameras. It has a maximum vertical resolution of 5200 pixels. Examples of rotational cameras 
are: Globuscope, Hulcherama 120s, Roundshot von Seitz, Lookaround and Mottweiler 
Fosterpan. 

 

 
 
 
 
3.5. Technologies of generating digital 360° panoramic images 
 

MAAS and SCHNEIDER [13] enumerate five various technologies that can be used to 
generate a digital 360° panoramic images.  

o Rotating linear array – a linear array image sensor is rotating around a vertical or 
horizontal axis. This type of camera is suited for recording static objects and should be 
mounted on a tripod. 
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o Image stitching – this technology is using a number of images that are taken with a 
conventional camera and then stitched to get one image. 

o Fisheye lens – an image is taken with a conventional camera equipped with a  180° 
fisheye lens. 

o Hyperbolic mirror - an image is taken by a conventional digital camera that looks 
vertically down or up onto a hyperbolic mirror. 

o Multisensor systems - four or more area sensors that are equipped with wide-angle 
lenses are combined to an omni-directional vision system. 

 
3.5.1. Rotating linear array 
 
 Special panoramic cameras outfitted with a pivoting lens or a swivel motor can be 
used to photograph complete panoramas in a single pass [12]. The panoramic picture is 
produced by scanning the scene in front of the lens. Most models allow different lenses to be 
fitted. In the case of digital panoramic camera the sensor moves around one fixed rotation 
axis. Panoramas taken with such camera require only one seam edge to be processed. More 
about this technology can be found in chapter 3.6. Examples of cameras that use this 
technology are: 

o Karline is produced by Dr-Clauss. It can take images even up to 400° horizontally and 
90° vertically. 

o SpheronCam HDR – the RGB line sensor allows for a maximum vertical resolution of 
5,300 pixels. After the shooting, the seam edge is stitched by software. It also has 26 
aperture stops so it uses HDR (High Dynamic Range) technology. 

o SASTAscan is a digital rotating scanner and it is produced by INNOTECH – HT 
GmbH in Germany. The company produces two models: DRS 3000 – C (colour) and 
DRS 5000 (black and white). 

o PanoScan is a camera that is set up on a special tripod and often two panoramas are 
scanned. Next the images are processed to ensure geometric accuracy. Finally the 
images are loaded into PanoMetric for measurements. The user simply points to any 
pixel in the scene and accurate distance and spatial data is displayed. Point to point 
measurement is fast and accurate. 

o Eyescan MM1 from Kamera und System Technik GmbH was used in the project of 
generation the high resolution virtual tour of the Dresden University of Technology 
campus. It can record all 360° in less than 30 seconds. Powerful camera computer is 
integrated in one box. There is a NIKON system for lenses. Vertical resolution is 3600 
pixels. More details about this model could be found in chapter 3.6.3. 

o Eyescan M3metric is a really professional panoramic camera from the same company. 
It captures all 360° degrees in extremely high resolution. CCD-line RGB has 10200 
pixels (see chapter 3.6-4). 

 
3.5.2. Image stitching 

 
 
 Fig.3.5-1: Image stitching technology [12] 
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 Image stitching is the most common technology of making panorama. A panoramic 
image is created by composing a series of rotated images (Fig. 3.5-1). In order to generate a 
panoramic image, one should ensure that the camera is rotating about an axis passing through 
its optical centre. This process is presented in chapter 6.3 on the example of program that is 
called PTGui.  
 
3.5.3. Fisheye lens 
 
 Fisheye lens could be used to create spherical panorama. A digital camera and digital 
panoramic camera are sometimes equipped with this lens. In the first case, two or three 
images taken with fisheye lens is enough to generate spherical panorama. The number 
depends on the program used. In the second case one gets also spherical panorama but this 
image does not need stitching process. More information about this technology is in chapter 
3.9. 
 
3.5.4. Hyperbolic mirror 
 
 This technology is used when a conventional digital camera looks vertically to a 
hyperbolic mirror. These curved mirrors usually are attached to the respective lens by way of 
an adapter and allow a 360° view to be captured in a single shot. This is only possible up to a 
certain horizontal field of view. The subsequent digital panoramic application of this type of 
photography is limited to the cylindrical format. There are the following examples of mirror 
technology: 

o PanoMAXX-Panorama-Optik 
o 0-360 Panoramic Optic™ Belissimo 0-360 Panoramaoptik 
o EyeSee 360   
o Surroundphoto 
o OmniEye 360º Cameras 
o VSTONE 
o Egg-Solution 
o Bowl Camera Construction 
o Behere Corp. 
o Remote Reality 
o Tateyama R&D 
o Fullview 
o Versacomp 
 

 
 
 
 
 
 
 
 
 
 
 
  
 Fig.3.5-2: A few examples of mirror technology [12] 
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Fig.3.6-1: Principle of digital panoramic 
image acquisition [14] 

3.5.5. Multisensor systems 
 
 We can get one panorama without stitching process in a short time, but we need a 
special digital panoramic camera. Event Cam (Fig. 3.5-3a) is a camera that does not rotate. It 
has ten digital cameras that are situated around the main part. This device is produced by 
VRMAC or Kaidan. Another camera that uses this technology is Ladybug (Fig. 3.5-3b). It is a 
camera that is produced in Canada by PointGrey Research Inc. It has six cameras and five of 
them are in horizontal plane. One camera is looking up. It makes automatically a spherical 
panorama. 
 
 
 
 
 
 
 
 
 
 

3.6 . Digital rotating line camera 
 
 The principle of scanning using 
digital panoramic camera is that this camera 
has a CCD linear array that moves linearly 
around the object [14]. In the case of digital 
panoramic camera the sensor moves around 
one fixed rotation axis with the projection 
centre on the rotation axis. In this way it 
describes a cylindrical surface (Fig. 3.6-1).  
Because of this system of scanning this kind 
of camera is also called rotating line 
cameras. Three channels of colours are not 
recorded strictly simultaneously, causing 
colour seams when recording moving objects. 
The scene around a camera is scanned in 
horizontal angle up to 360°. The vertical 
opening angle is depended on: 

o focal length 
o sensor length 
 

 Instead of having a CDD chip typical for digital chip cameras, these cameras are 
equipped with the RGB line sensor. When a scene is being photographed, the camera rotates 
about its axis via a motor in order to capture, or scan, the complete environment. Due to the 
scanning technology they employ, digital panoramic cameras are not very well suited to 
filming moving objects. The amount of daylight present influences the rotational speed of the 
camera as it takes pictures. While the time required to film a panorama with sufficient light is 

R G B B 
G 

R 

(a)      (b) 
Fig.3.5-3: Two examples of multisensor systems: Event Cam and Ladybug [12] 
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Fig.3.6-3: The process of taking this night panorama 

around 1 minute, more darkly lit scenes easily can result in shooting times of 10 minutes and 
more. It is ineffective to take pictures during the night with such cameras, as the exposure 
process is extremely long and moving lights lead to distortion in the form of stripes. However 
one night panorama (Fig.3.6-2) was taken at the university campus in Dresden. It was done to 
test (Fig. 3.6-3) digital panoramic camera.  
 

 
 

 
 
 
 
 
 
 
 
 
 

 
 Digital panoramic cameras can only be used when connected to a notebook. The 
pictures taken are controlled by the computer and saved on its local hard disk. The software 
for this comes with the camera and will function only when the camera is connected.  
 
3.6.1. Advantages of digital panoramic cameras 
 

o One shot is all it takes to create a fully spherical view. 
o No stitching required; only the seam edge needs to be edited. 
o A panoramic image can be taken in a dozen of seconds. 
o When the notebook is connected directly to the camera, the resulting picture can be 

visually analyzed. 
o Due to the high resolution, the resulting image quality is sufficient for making 

printouts. 
 

3.6.2. Disadvantages of digital panoramic cameras 
 

o The camera is really expensive and can be used for panoramic photography. 
Traditional shots cannot be taken. 

o Due to the scanning technology employed, unwanted distortion errors can arise when 
filming moving objects. 

o Operation is only possible when a notebook is connected, which controls the shooting 
process. Data are transferred to the notebook as the picture is taken and saved on the 
local hard disk. 

o A white strip can appear in that part of the picture where direct contact with sunlight 
was made. This phenomenon is known as blooming. 

Fig.3.6-2:  The realistic night scene at the TU Dresden campus. Crossing of George-Bahr-
Strasse and Helmholtzstrasse. 11:30pm; 28mm lens; shutter speed: 1/3s; aperture: F2.8; 

horizontal angle 360°; 1/8 resolution and time of taking this panorama: 26minutes 
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Fig.3.6-4: All-in-one – Eyescan MM1 

Fig.3.6-5: Front of the 
camera - Eyescan MM1 

[10] 

Fig.3.6-5: The front of the Eyescan MM1 [15] 

3.6.3. Eyescan MM1 
 This is a digital panoramic camera from 
Kamera und System Technik GmbH. It is 
produced in Pirna near Dresden in Germany. 
This camera was provided to this project by Mr 
Hans-Jörg Schönherr. This instrument joins the 
advantage of digital photography and a 
traditional rotational panoramic camera. It can 
be used in many places to take landscapes, 
architecture, real estate, museums, industry and 
advertisement. Eyescan MM1 is perfect solution 
for high quality prints and application for CD-
ROM and stand-alone viewers. Camera is 
integrated with a box (Fig.3.6-4) in which one 
can find a powerful computer with wireless 
keyboard. One of the advantages is the short 
time of scanning. This time depends on the lens 
that is mounted to the camera. What is more, the 
aperture and the shutter speed have also an 
influence on the speed of rotating camera. This 
camera uses Nikon’s interchangeable lenses. 
The camera uses a power supply which is also 
visible in the picture on the left side of the box. 
In the measurement, two batteries were used. 

One of the batteries was for a computer and the second one was for the camera. Two batteries 
were used because of long distance of walking with the eqipment from the Institute of 
Photogrammetry and Remote Sensing where batteries were loaded. These batteries supported 
4 hour session of taking panoramic images in different places of the TU Dresden campus. In 
the Figure 3.6-5 one can see an UV-IR – cut off filter, that is mounted behind the lens and 
protect the sensor inside the camera. There are two main purposes of using this filter. Firstly it 
protects the sensor against dust. Secondly it optimises colours and allows the use of super 
wide angle lenses without any losses. Eyescan MM1 is controlled by a special user interface. 
Program that controls this camera is called IcaScan. This program is clearly and practically 
designed.  
Eyescan MM1 consists of a few main elements: 

- camera  
- camera head 
- rotation drive 
- camera computer 
- 12,1’’ TFT-Screen 
- wireless keyboard 
- software: IcaScan 
- cable set 
- rechargeable battery 
- power supply for stationery use 
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Tab.3.6-1: Technical data of the digital panoramic camera Eyescan MM1 [15] 

3.6.3.1. Technical data (see Tab. 3.6-1). 
 

Camera Eyescan MM1 
Feature Detail 

vertical resolution 3600 pixel each vertical 

active line lenght 29mm 

pixel size 8 m 

data format 24 bit RGB (bmp, uncompressed) 

data rate 2Mpixel/s (24 bit RGB) 

ISO 100 - 400 

shutter speeds [s] 1/360; 1/180; 1/90; 1/45; 1/22; 1/11; 1/6; 1/3  

angle of view [°] 5; 11; 22; 45; 90; 135; 185; 225; 270; 315; 360; 380 

shortest scanning time 30s for 360° in full resolution using 14mm lens; up to 8 times 
faster in reduced resolution 

white balance manual, list of presets, different light situations storable in 
personal list 

file size for example 250 MB for a full 360° scan using a 28mm lens 

lens type NIKON with integrated UV-IR cut off filter 

standard focal length 28mm 

camera control direct from the camera computer 

tripod connecting 3/8’’ and ¼’’ 

power supply 12V DC 

Camera computer 
processor Pentium III, 800MHz 

RAM 768MB RAM 

hard disc 20GB 

screen 12,1’’ TFT-LCD monitor 

system Windows 2000 

keyboard wireless IR-keyboard incl. track ball 

ports Ethernet – interface RJ 45 
USB port 
parallel port 
serial port 

camera software pre-installed 

Power supply 
battery rechargeable battery (12V/11Ah) or external power supply 

possible 
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3.6.3.2. Resolution potential  
 
 Resolution potential of the Eyescan MM1 is shown on the example of one part of the 
panorama (Fig.3.6-6) that was taken near Café on the crossing of Hettnerstrasse and George-
Bähr-Strasse at TU Dresden campus. 
 

 
 
3.6.4. Eyescan M3metric 
 

 In comparison to Eyescan MM1, this model – Eyescan 
M3metric (Fig.3.6-7) – has higher vertical resolution. This camera 
is produced by the same producer. M3metric has one line sensor for 
each colour channel. That is why true colour information is 
recorded without any filter patterns and interpolation techniques. 
This camera has three CCD lines with maximal vertical resolution 
of 10.200pixel. MAAS and SCHNEIDER in [11] presented some basic 
parameters for this camera (Tab.3.6-2).  
 

 
 
 

Lens 28 mm 35 mm 45 mm 60 mm 100 mm 180 mm 

Vertical opening angle 100° 90° 80° 60° 40° 22° 
       

Data volume  
(360°, 48 Bit) 

1.4 GB 1.7 GB 2.3 GB 3.1 GB 5.1 GB 9.9 GB 

       
Recording time 

(360°, 5 ms /column) 2 min 2.4 min 3.1 min 4.1 min 6.9 min 12.4 min 

 
Tab.3.6-2: Basic parameters of Eyescan M3metric [14]. 

Fig.3.6-7: Digital panoramic camera M3metric [14] 

a) 20% of the original zoom 
 
 
 
 
 
b) Original 100% zoom 
 
 
 
 
c) 1000% - ten times zoom 
 
 
 
Fig.3.6-6 a,b,c: Resolution potential of the camera 
Eyescan MM1 illustrated through 3 zoom steps.  
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3.7. Lenses used in creating the virtual tour of the Dresden University of 
Technology campus 

 
 This section clarifies a few important terms before delving into the topic of panoramic 
production. A wide variety of lenses can be used in panoramic photography. In order to 
determine the number of pictures required for a panoramic picture, it is critical to know the 
size of the field of view of the lens being used. The larger is the field of view, the fewer are 
the pictures that need to be taken using a conventional camera.  
 
3.7.1. Field of views 
 
 There is a little glossary about field of views on the bases of  Panoguide.com [1]: 
 
3.7.1.1 FOV 
 
 Short for “Field of View”. 35mm cameras produce rectangular pictures (36 x 24mm 
negatives) and therefore the field of view is greater for the longer dimension. Generally when 
someone refers ambiguously to the field of view of a 35mm image they are referring to the 
field of view along the longer of the two dimensions, regardless of which way up the camera 
was (portrait or landscape). 
 
3.7.1.2. HFOV  
 
 Short for "Horizontal Field of View". This is the horizontal angle in degrees that a 
particular image represents of the world. The wider is a lens the greater is the angle of view. 
When using a 35mm camera the HFOV is calculable from the focal length as follows: 
if camera is used portrait 
HFOV = 2 * tan-1(12 / focal_length)  
if camera is used landscape 
HFOV = 2 * tan-1(18 / focal_length) 
 
3.7.1.3. VFOV  
 
 Short for "Vertical Field of View". This is the vertical angle in degrees that a 
particular image represents of the world. The wider is a lens the greater is the angle of view. 
When using a 35mm camera the HFOV is calculable from the focal length as follows:  
if camera is used portrait 
VFOV = 2 * tan-1(18 / focal_length)  
if camera is used landscape 
VFOV = 2 * tan-1(12 / focal_length) 
 
3.7.2 Three lenses used in measurements 
 
 Three lenses were used during the measurements of creating the virtual tour. Numbers 
of image columns and data volume are presented in Tab.3.7-1. In this table  one can find the 
numbers of panoramic images divided to different lenses used and their part in all the virtual 
tour.  
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Lens Number of image 
columns (360 °) 

Data volume 
  (360 ° and 24 bit) 

 

8mm 
(f=7.8mm) 
FISHEYE 

 

 
6126 

 
69MB 

 

 
14mm 

 
11333 

 
122MB 

 

 
28mm 

 
22777 

 
248MB 

Tab. 3.7-1: Comparison between three lenses used in this diploma project. 

Lens Fisheye - 8mm 14mm 28mm 

Number of 
panoramas 
recorded 

16 24 9 

A part in the 
whole project 

32 % 49 % 19 % 

 
Tab. 3.7-2: Number of panoramic images that was made using different lenses 

 
 These three kinds of lenses were used in creating the virtual tour (Fig.3.7-1, 3.7-2 and 
3.7-3). The following pictures (Fig. 3.7-4, 3.7-5 and 3.7-6) will show the difference in the 
field of view when using one of these three lenses. It is easy to see that the maximum field of 
view is for the shortest focal length and the minimum for the longest focal length. But not 
only is field of view changing when we change lens attached to the camera. Number of image 
columns is also changing. The shorter is the focal length the less are numbers of columns in 
360° image. What is more data volume is increasing when the focal length is increasing its 
length. Three different lenses attached to the Eyescan MM1 are shown below: 
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Fig.3.7-4: 90-degree part of 
panorama (no.35)  taken with 

8mm lens 

Fig.3.7-5: 90-degree part of panorama (no. 35) 
taken with 14mm lens 

 
Digital panoramic camera Eyescan MM1 

+ 

Fig. 3.7-1: 
8mm Fisheye lens 

Fig.3.7-2: 
14mm lens 

Fig.3.7-3: 
28mm lens 

These test panoramic images (Fig.3.7-4 – 3.7-6) were taken in front of the back door of 
Hörsaalzentrum at the Dresden University of Technology campus. 
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Fig.3.7-6: 90-degree part of panorama (no. 35) taken with 28mm lens 

Fig.3.7-7: The true 
fisheye image [9] 

Fig.3.7-8: The 
quasi fisheye [9] 

 As we can see from the previous three parts of panoramas the 
vertical field of view is changing due to the changes of the focal length. 
In the (Fig.3.7-4) there is even a part of a tripod. Vertical field of view 
for fisheye image is 180°.  
 Looking on these pictures we can easily answer the question why 
three lenses were used in the measurements. Fisheye lenses were used 
when panoramas were taken just near a high building or other object like 
high chimney. When there were no high buildings there was no sense to 
use fisheye lens, because the sky consists the greater part of panoramic 
image. On the second hand the resolution of images that were taken with 

fisheye lens is worse than images received by applying the other types 
of lenses. 
  
3.7.3. Fisheye lens  
 
 A few words about fisheye lens will be citied from “The Focal 
Encyclopedia of Photography” [16]: 
Fisheye lens is a lens with extreme angle of coverage. The geometry of 
orthoscopic image formation and image illumination limit the angle of 
coverage of a distortion-free lens to about 120 degrees.[..] There are two 
versions of such fisheye lenses. The quasi-fisheye (Fig. 3.7-8) has a circle 
of illumination that circumscribes the film format and gives 180 degrees 
angle of view across the diagonal. The true fisheye (Fig. 3.7-7) has a 
circular image area wholly within the format, thus including more of the 
scene. The diameter of the image circle depends on the focal length (f).  
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Fig.3.8-1: Mounting the camera Eyescan MM1 on the tripod 

Fig.3.8-2: Control wire 

3.8. Process of taking a panorama using Eyescan MM1  
 
 Eyescan MM1 is easy to handle and is also called “All in One” system because all 
components of the system are included in the camera case. The following instruction will 
show how to deal with this camera, how to setup it up, and finally how to do the scan [17]. 
 
3.8.1. Camera assembly 

a. Mount the camera on a tripod (it is possible to mount it on one of the 
common threads: ¼” and ¾”. (Fig.3.8-1) 

b. Level the camera 
c. Attach the data and control wire – attach the 15 pin D-SUB plug to the 

socket on the back of the camera and tighten the locking knobs 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
d. Attach the control wire (Fig.3.8-2) to the COM 1 – interface at the camera 

computer and tighten the locking knobs. 
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Fig.3.8-3: The connection of cables to camera computer 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
e. Attach the data wire to the data port (Fig.3.8-3) 
f. Attach the IR – sensor and the keyboard. Connect the IR-sensor to the 

camera computer. Fit the sensor in the top of the camera case using the 
already mounted Velcro strip. 

g. Connect the camera and the camera’s computer to the rechargeable battery 
(Fig. 3.8-4). 

 
The capacity of one battery is good enough for about 1.5 hour work of the system. 
 
3.8.2. How to do the “Scan”? 
 

a. After you connect the camera to the computer and the power supply to the 
camera, the device is ready to take pictures. Switch on the computer and 

Fig.3.8-4: The connection of cables to the battery 
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Fig.3.8-7: IcaScan – selecting lens type 

start the program “IcaScan”. By hitting INIT button (Fig.3.8-5) you 
initialize the camera. 

 
 
 
 
 
 
 
 
 

b. The camera is operated by the following buttons (Fig. 3.8-6) in this 
program: 

 

 
 

 
 
Pressing “<<” and “>>” makes the camera rotate quickly, and pressing 
“<” and “>” causes that horizontal angle of camera movement is 
smaller than the angle described above. The “*” button is for storing the 
new position of the camera.  

c. The next step is to select the lens of the camera. One should choose a focal 
length of the lens.(Fig.3.8-7) 

 
 

 

Fig.3.8-6: IcaScan – camera operating buttons 

Fig.3.8-5: IcaScan – INIT button 



Generation of a virtual tour in the 3D space applying panoramas, exercised on the sites of Dresden and Cracow 

 
 

 Karol Kwiatek, AGH University of Science and Technology, Cracow 2005  32 

. . . 
[Lens14] 
name=28mm lens 
R=28.0 
 
[Lens15] 
name=Fisheye 
R=7.8 

 One of the most important things was to add information about fisheye lens to this 
data base.  

 
d. Adding an additional lens 

 
 Eyescan MM1 allows the program IcaScan to add extra lenses. This 
process could be done by adding 3 extra lines (in bold in Tab. 3.8-1) in the 
INOVISION.INI file. This file is located in the folder where IcaScan is 
installed. 

 
 
 
 
 
 
 
 
 
 
 

Tab. 3.8-1: Adding an additional lens to INOVISION.INI file 
 

 The other two lenses that were used in measurements were pre-defined 
in this file. Note that more than 16 lenses cannot be added to this file 
because the seventeenth would not be seen in this menu (Fig.3.8-7). R is 
the radius that is a characteristic value of every lens. For the fisheye lens 
used in the project this radius is not 8.0mm but 7.8mm. 

 
e. Selecting shutter speed and angle of view (Fig. 3.8-8) 
 

                                    
 

f. Selecting the resolution (Fig. 3.8-9) 
 
It is possible to select the resolution of the final image just before taking the 
image. One can choose from four options: 
“1x” – full resolution (3600 Pixel vertically) 
“2x” – half resolution (1800 Pixel vertically)  

Fig.3.8-8: Selecting shutter speed and angle of view 
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Fig.3.8-10: Pre-settings in IcaScan. 

“4x” – 1/4 resolution (900 Pixel vertically) 
“8x” – 1/8 resolution (450 Pixel vertically) 
For the maximum resolution the camera makes the best quality of the image 
but it takes much time. On the other hand one can get the shortest scanning 
time by taking a panorama with 1/8 resolution. 
 

 
 
 

 
g. Picture taking 

o Pressing this button will start scanning   
o The camera head moves counterclockwise. After the scan, the camera 

will go back to the “0” position. At the same time the computer starts to 
open the image on the screen. 

o The scan stops scanning when STOP button is pressed. 
o After a while an image appears on the screen. 
o The image is saved as a BMP and not compressed file. 
o Then one can close all programs and put the camera to the box. 
 

h. Storing individual pre-settings: 
 

IcaScan can store different pre-settings of light situations. This feature 
makes it also possible to store light situations like daylight or different 
lamplight. Typical light settings are stored in 
INOVISION.INI: 
The most important pre-settings (Fig. 3.8-10) in the 
measurements were: 
CLDY 680 for cloudy wheather, RAIN 680 for rainy weather 
and SUN 680 for bright sun light (Tab.3.8-2).  
 

Recommended settings are: 
 

Light situation White balance 
R/G/B 

ISO  
 

Shutter 
speed 

Aperture 
setting 

Sunlight 
SUN 

15/ 26/ 2 
 

160 
 

1/360 8 
   1/180 11 
Cloudy sky 46/49/13 200 1/180 5.6 
   1/90 8 

 
Tab.3.8-2: Recommended light pre-settings. 

 
 
 
 
 
 
 
 

Fig. 3.8-9: IcaScan – selecting the resolution 
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3.8.3. Icascan’s interface 
 
The most important functions in IcaScan interface are (Fig. 3.8-11): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1- Initialization of the camera 
2- Adjustment of the “0” position 
3- Stop of scanning 
4- Preparation of the settings 
5- Start picture taking 
6- Save the picture 
7- Selection of the screen 
8- Selection of the resolution 
9- Selection of the lens type 
10- Selection of the shutter speed 
11- Selection of the angle of view 
12- “Color lock” 
13- Pre-setting of light situation 
14- Save pre-setting 
15- White balance 

 
 
 
 
 
 
 
 
 

Fig.3.8-11: All the function from IcaScan 
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3.9. Creating spherical panoramas 
 
 Spherical panoramas became very popular in virtual tours. According to the panoramic 
images, spherical images give you something extra which is the ability to look vertically up 
and down.  
 Spherical panoramas can be photographed using special panoramic cameras. 
Alternatively, there is the option of taking one or more sequences of individual pictures that 
overlap each other by a certain percentage. The number of pictures required is a function of 
the focal length of the lenses used. 
 There are some methods available to make a spherical panorama: 

o use an ultra-wide angle fisheye lens that allows you to capture at least 180 
degrees vertically 

o use a parabolic mirror device horizontally with specialist software 
o shoot more than one row of pictures 
o use 14 or 15mm wide lens in such a way you can add “up” and “down” shoots. 

These four methods were described in Panoguide.com [1]. The next method that was used in 
creating the virtual tour of TU Dresden campus is not described in that source. This 
technology is based on using digital panoramic camera and fisheye lens and it was a little 
mentioned by JACOBS [18].  
 
3.9.1. Digital panoramic cameras and fisheye lens 
 
 While analog cameras are typically limited to photographing cylindrical panoramas, 
digital panoramic cameras are capable of taking cylindrical and spherical panoramic shots. 
The only way to produce a spherical panorama using digital panoramic camera is to apply it 
with fisheye lens. Digital panoramic camera has a RGB line sensor that scans whole sphere. It 
makes some kind of Half Slices. (Fig. 3.9-1b)  Then the mosaics of these half slices make a 
full spherical image (Fig. 3.9-1a). 
 

 
 
 
Fig.3.9-1: A single rotation of a 360° slice sensor produces a higher resolution spherical 
mosaic. (a) Each slice corresponds to a greater circle on the sphere. (b) Half of the slice 

maps to a line in the spherical panorama. [19] 
 

(a) (b) 
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Fig.3.9-2: Rotation of a slice camera with the center 
of projection away from the axis of rotation. RGB line 

sensor scans the vertical field of view of 180° [19] 

    
 

 
 
 
 
 

 When the digital panoramic camera (Fig. 3.9-3) rotates around the axis of rotation not 
all the area of the surrounding of camera is scanned (Fig.3.9-4). There will be some 
information missing at the top (zenith) and the bottom (nadir) of the sphere. Figure 3.9-4a 
shows not corrected spherical image that produce “a hole” in the sky (Fig. 3.9-4b) and a 
tripod is also visible in this image. The “hole” in the sky is reduced in the Figure 3.9-5. The 
solution of correcting the zenith and the nadir is also discussed in chapter 4.2.6. 
 

 
 
 
 
 
 
 
 

Fig.3.9-3: Eyescan MM1 
with Fisheye lens mounted 

on the tripod 

Fig.3.9-5: (a) 360° panorama near HSZ 
at the TU Dresden campus (b) The “hole” 

in the sky is corrected 

(a) 

(b) 

Fig.3.9-4: (a) 360° panorama near HSZ 
at the TU Dresden campus (b) The “hole” 

in the sky 
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3.9.2. Single row-techniques 
 
3.9.2.1. Using two fisheye pictures 
 
  One spherical panorama was created using a conventional digital camera (not 
panoramic) Nikon D100 from the Institute of Photogrammetry and Remote Sensing at the 
Dresden University of Technology and fisheye lens. The panorama was taken in the 
courtyard of the Schumann’s building at the TU Dresden campus. Two pictures were 
taken (Fig. 3.9-6 and 3.9-7). 
 

   
 
 
 
 
 

 
 
 

 
 
 
Working with iPIX Interactive Studio 
 
  After importing images on the hard disk a program which is called iPIX 
Interactive Studio were used to generate one spherical panorama. This program allows 
editing fisheye pictures with the field of view of 180°. First, both hemispheres are 
imported via File > Open. In order to edit two fisheye pictures, Fisheye is selected by 
Scene Category and 2-Shot-Fisheye by Scene Type (Fig.3.9-8). 

Fig.3.9-7: Back hemisphere used in iPIX Interactive 
Studio to create spherical panorama – the courtyard at 

the Dresden University of Technology 

Fig.3.9-6:. Front hemisphere used in iPIX Interactive 
Studio to create spherical panorama – the courtyard at 

the Dresden University of Technology 
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 After the individual pictures have been imported, the software automatically generates 
a stitched view of the panorama. In order to save stitched spherical panorama, one should 
click to File> Save to access the Save as dialog field. In the demo version the panorama is 
saved with the watermark on it. To create a spherical iPIX panorama, select the iPIX Image 
file format. This file can be later viewed in iPIX Viewer (Fig.3.9-9). 
 

 
 
 
 
 

 In this picture (Fig.3.9-9) we can see that the stitching process did not correctly made 
a panorama. Some displacement and colour changes are visible at the top right part of the 
picture. This is probably because of not rotating camera with fisheye lens of exactly 180° and 

Fig. 3.9-8: Both fisheye pictures are imported to iPIX Interactive Studio 

Fig.3.9-9:  iPIX Viewer: the watermark was created in demo version 
of iPIX Interactive Studio, and it is visible in this viewer 
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colour differences could be because of the different white balance while taking these two 
pictures.  
 iLinker is another program that allows you to link several iPIX panoramas into virtual 
tours. In addition, text information and sound can be added to hot spots.  
 
Advantages and disadvantages of this method 
 
 JACOBS [18] points some advantages and disadvantages of this method. 
Advantages: 

- Only two pictures need to be taken, making the time to complete panorama relatively 
short. 

- Due to the large field of view associated with fisheye pictures, moving objects 
represent no problem as long as they are not located towards the edge of the picture. 

- The software is relatively easy to use. 
Disadvantages: 

- As only two pictures are taken, the resolution of the spherical panoramas is not very 
high when compared to other techniques that use more pictures. Alternatively, there is 
the option of using three fisheye pictures with iPIX Interactive Studio. 

- In order to ensure a perfect end result, the seam edge usually needs to be retouched. 
- iPIX panoramas appear distorted in some areas.  

 
3.9.2.2. Using a parabolic mirror horizontally 
 
 Instead of fisheye lens, one can use a parabolic mirror 
and position it horizontally to create a spherical panorama 
(Fig. 3.9-10). 
 
 
 
3.9.3. Shooting more than one row of pictures 
 
 This shooting could be done by 14mm lens. At first one should move the camera 
slightly up and take picture and then do the same but with moving the camera slightly down 
(Fig. 3.9-11). The main problems are that there are too many pictures. It is also important to 
take care about exposure (while taking images left to right and up to down). 
 

 
 
 
 
Advantages and disadvantages of this method 
 
According to JACOBS [18] the advantages are the following: 

Fig.3.9-10: Parabolic mirror [3] 

Fig.3.9-11: Two rows of pictures [1] 
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- The multi-row technique does not require special camera equipment; practically any 
camera and lens combined can be used. 

- The high number of pictures increases the resolution of the complete panorama. 
Disadvantages: 

- A special panoramic tripod head is recommended in order to exactly align the camera 
for multi-row shots. 

- Depending on the field of view of the lens, there is a need to take from 15 to 50 
pictures in order to create a spherical panorama. 

- The relatively high number of pictures associated with the technique demands more 
time for shooting and stitching. 

- The multi-row technique presents problems when moving objects are introduced. 
Thus, it cannot be ruled out that such objects will appear incomplete in the panorama. 
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4. Editing panoramic images 
 
4.1. Panoramic production 
 
 Before some details about edition of panoramic images will be described, here is a 
brief overview on panoramic production. 
 
4.1.1. Taking pictures 
 
 The most popular way of creating a panorama is to take one or more picture sequences 
and overlap the individual pictures by a certain percentage. With this method, the camera is 
turned by a specific angle to the position where the next picture is to be taken until entire 360° 
revolution has been completed. After that, pictures are stitched to make a panoramic picture 
using special stitching software. Type of the panorama (cylindrical, spherical or cubic) 
depends on the number of individual pictures and the selected projection format.  
 Taking pictures with a panoramic camera is the second method of getting a panorama. 
The camera can be analog or digital and works by rotating once about its own axis while 
shooting the panorama to record the complete environment. For a digital 360° panorama, 
usually only two seam edges need to be stitched. The projection type depends on the lens 
used. 
 
4.1.2. Correcting image distortion 
 
 Before stitching images in special program, all images need to be corrected. The 
pincushion and barrel distortion as well as vignetting and chromatic aberration are errors that 
should be corrected. Distortion of the panorama that was taken with digital panoramic camera 
is not necessary to correct. 
 
4.1.3. Stitching individual pictures 
 
 The next step in panoramic production is to stitch individual pictures to make a 
panoramic picture. The parameters that are necessary for stitching program are the type of 
lens used, focal length and field of view. Stitching program normally connects the pictures by 
overlapping them in order to create a soft, invisible transition. This process will be described 
more detailed on the example of creating panoramas for stereo panoramas (see chapter 6). 
That process was carried out in program PTGui.  
 
4.1.4. Retouching the panoramic picture 
 
 There are many problems on panoramic images that need to be retouched. When 
creating a spherical panorama, the legs of the tripod appear in the bottom of the picture at 
some point. In areas that are called zenith and nadir retouching is necessary. The procedure 
for doing this depends on how the scene was shot and what kind of program is used. 
 
4.1.5. Publication of the panorama 
 
 There is variety of ways to publish finished panoramas. Publication depends also on 
projection type. Some of them can be printed and almost all of them can be published in the 
Internet. Viewers are necessary to watch panoramas on the computer’s screen.   
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Fig.4.1-1: The 
photographer’s 

shadow on the street – 
spherical panorama 
(Panorama no.13) 

Fig.4.1-2: 
“Blooming” – the 

problem with direct 
sunlight 

(Panorama 6) 

4.1.6. General tips 
 
 In conventional photography there were no big problems 
with illumination of different parts the picture. In panoramic 
photography a person who takes a picture should be sure that there is 
the ideal amount of illumination. If pictures are taken in daylight or 
artificially lit settings, there is not a great deal of problems to avoid. 
When mixed light situations are introduced, it is much more difficult 
to get a uniform panoramic colour scheme.  
 It is suggested that the same settings should be used when 
taking all pictures for a panoramic sequence. White balance, ISO 
value, aperture and shutter speed must be exactly the same for every 
picture. Doing this there are no differences in contrast and in 
illumination between the individual pictures.  
 A large depth of field typically is desired when taking 
panoramic shots. In order to achieve a high depth of field, a small 
aperture (large F-number) should be selected. The amount of light is 
influenced by selecting the appropriate exposure time. Longer 
exposure times are not problematic, as the camera usually is 
mounted on the tripod for the panoramic session.  
 During a panoramic session indoor and outdoor there could 
be a problem with sunlight. There is a risk that the panoramic shots 
will reveal fluctuations in brightness. This is why it is recommended 
to take panoramas either in sunlit or in cloudy conditions. This tip is 

important because not doing this there 
will be varying patches of light in a 
panorama.  
 Taking panoramas in sunlight 
makes a possibility to take the 
photographer’s shadow (Fig.4.1-1). 
This problem could be easily corrected in computer software.  
 It is recommended not to take pictures in windy weather. 
Plants can be blown around and be in different location in every 
second. After stitching or during taking picture with digital 
panoramic camera the plants appear “blurred” in the panorama.   
 Another point to keep in mind is that the tripod itself never 
should move during a panoramic shooting. Moving picture 
elements are always problematic. Taking pictures with a 
conventional camera one should consider that moving objects that 
are photographed must not be in the overlapping section of the 
pictures. While taking panoramas with digital panoramic camera 
there is no possibility to record moving objects.  
 One of the most important recommendations is to take fully 
charged batteries. What is more when outdoor pictures are taken 
there is a risk of encountering problems with direct sunlight. Such 
light can cause the CCD sensors to overexpose, which is known as 
“blooming” (Fig. 4.1-2) in digital photography. In order to prevent 
this negative effect, direct sunlight should be avoided. It is 
advisable that the photographer could wait until the sun is a little 
lower in the sky or has disappeared behind a cloud for a longer 
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Fig.4.2-1: One seam edge need to be corrected (a fragment of Panorama no. 7) 

time. This area should be retouched in graphical program like Adobe Photoshop. The effort is 
worth a while, as the result typically looks better than an overexposed picture. 
 
4.2. Correcting panoramic images taken with digital panoramic camera 
 
4.2.1. One seam edge 
 
 In panoramas with horizontal field of view of 360° that were taken with digital 
panoramic camera only one seam edge need to be processed. In this project fifty three 
panoramas were taken. In all panoramas this edge was controlled and in most cases some 
columns of pixels need be deleted (Fig.4.2-1).  
 
 
 
 
 
 
 
 
 

 
How to correct? 
 This problem was always fixed in Adobe Photoshop. For instance last fifty or more 
columns of pixels were copied from the end of image to the beginning of the image and new 
layer was created. The other part need to be also copied on a new layer and moved to right 
until this new part will join perfectly to the second part. Image flattening is important in this 
place (Layer-> Image Flatten). Empty space at the end of the image ought to be selected with 
Select Tool. Next step is to select the inverse (Select -> Inverse or CTRL+Shift+I) and then 
cut this selected part. This part that is in the clipboard should be pasted in a new image (File-
>New) and than saved (File ->Save) as TIFF. Corrected image should be checked in 
FSPViewer (see chapter 5.2.1) if there are no mistakes on the seam.  
 
4.2.2. Problem of sixteen pixels 
 
 This problem occurred in every panoramic image that was taken with Eyescan MM1. 
The last sixteen columns of pixels were always black (Fig.4.2-2). There was completely no 
information. 

 

 

Fig.4.2-2: Screenshot from Corel Photo Paint showing 16 black columns  
of pixels at the end of a panorama 
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Fig.4.2-3: A fragment of panorama no.42 
with moving people recorded 

Fig.4.2-4: A fragment of panorama no.42 
with moving people that are going to be 

covered up 

Fig.4.2-5: A fragment of panorama no.42 
with moving people that were covered up 

How to correct? 
  
 This problem is similar to the first one (see chapter 4.2.1). It could be corrected during 
the control of the one edge seam. (see chapter 4.2.1). To correct this problem, a Rectangular 
Marquee Tool ought to be chosen in Adobe Photoshop. Then Style should be changed to 
Fixed Size. In this place the size of selecting area could be inputted. Width should be 16px and 
Height:3600px. Then the last column of the image should be clicked. Then the inverse must 
be chosen (Select->Inverse). This selected area could be after that copied and pasted to a new 
image and finally saved. 
 

4.2.3. Moving objects 
 
 It was nearly impossible to take a 
panorama at the campus in Dresden without any 
students. But most of them did not stop while the 
camera was taking the panoramic image. The 
process of taking panorama for example number 
42 took about 40 seconds. Eyescan MM1 needs 
some time to rotate around its axis. During the 
last seconds of taking this panorama that is 
presented in Figures 4.2-3 - 4.2-5 some students 
went through the scanning area. That is why they 
are not correctly presented in this panorama.  
 

How to correct? 
 
 While the camera was rotating around its 
axis and it was taking 360° panorama, the 
scanning area was observed. When some objects 
such as cars or people moved in this area then 
this situation was noticed by the photographer. 
The angle of panorama where there was a 
movement is also noticed. Then only a part of 
surrounding is taken. In IcaScan, (the program 
for scanning with EyeScan MM1) one could 

define the horizontal angle of scanning. In the 
Figure 4.2.4 the hexagon was cut from the 
image that was taken in the second part when 
people disappeared from that place. It is 

important to join the small part of the image with 
the background. This process must be done with 
magnified image. After all the process the image 
must be flattened (Layer->Flatten Image).The 
resulting part of panorama is shown in the Figure 
4.2-5.   
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Fig.4.2-6: The way of cropping spherical panorama no.5 

Fig.4.2-7: The diameter of the hole for Fisheye-Nikkor 8mm f/2.8 and the area of cropping. 

4.2.4. Cropping fisheye image 
 
 Before correcting chromatic aberration it is important to crop a fisheye image. The 
method of cropping one of the spherical panoramas is shown in Figure 4.2-6. 
 

 

 This process must be done, because in correcting chromatic aberration, one needs the 
centre of the image for further calculations. The resolution of the image (Fig.4.2-6) is 
6126x3600 pixels. The aspect ratio of spherical panoramas should be 2:1. Dividing 6126/3600 
one gets 1.7. The size of the pixel is 0.008 mm. The size of the radius of the hole for circular 
fisheye lens (Fig. 4.2-7), that was used in the project, is exactly 11.5mm. The diameter is 
23mm. 
  
 
 
 
 
 
 
 
 
 
 

 Dividing the size of the diameter by the size of the pixel, one gets the amount of rows 
of pixels that create the image (without black parts).  
 
 23mm / 0.008mm = 2875 [pixels]      (4.1) 
 

23mm 
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Fig.4.2-8: Longitudinal Chromatic Aberration 
Focal length varies with color wavelength [20] 

Fig.4.2-9: Transverse Chromatic Aberration 
Magnification varies with color wavelength [20] 

 The horizontal resolution of the spherical panorama is 6126 pixels. One should find 
the vertical resolution. The aspect ratio of 2:1 is not important now. Next cropping will be 
done after correcting chromatic aberration. In Adobe Photoshop one can get coordinates of 
pixels in the image in palette Info. The number of the rows of pixels should be calculated for 
the black pixels under the image, because this area is smaller than the same black area over 
the image. There are 270.5 black rows of pixels under the image. The calculation of vertical 
resolution is: 
 
 2875 [px] + 270.5 [px] * 2 = 3416 [px] (4.2) 
 
 The result of cropping should be similar to the red dotted rectangle that is drawn on 
Figure 4.2-6.and Figure 4.2-7.  Now chromatic aberration could be corrected. After this two 
black areas should be edited. 
 
4.2.5. Chromatic aberration 
 
 Chromatic aberration is a common lens error visible in images as coloured blur along 
edges. It is caused by a different refractive index of glass for light at different wavelength. 
According to Digital Photography Review [20] this error appears because camera lens does 
not focus different wavelengths of light onto the exact same focal plane (the focal length for 
different wavelengths is different) and/or by the lens magnifying different wavelengths 
differently. These types of chromatic aberration are divided to Longitudinal Chromatic 
Aberration and Lateral Chromatic Aberration. The amount of chromatic aberration depends 
on the dispersion of the glass. 
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Fig.4.2-10: Achromatic / Apochromatic Doublets [20] 

Longitudinal Chromatic Aberration (Fig. 4.2-8) 

 Different refractive index means different focal length for a single lens. This would 
lead to different focal planes for different colours. One would have to focus differently for 
red, blue or green. This effect is called longitudinal chromatic aberration (LCA). If one has a 
fringe near the image centre that changes colour if you defocus slightly, this is most likely 
longitudinal chromatic aberration. This type:  

·  can not be corrected by software  
·  gets less if stopped down  
·  is dependent from focus distance.  

Transverse Chromatic Aberration (Fig. 4.2-9) 

 When a lens is corrected for longitudinal chromatic aberration, different colours focus 
more or less in the same point on the optical axis, but they might focus in different distances 
of axis resulting in images of different size for different colours. This type is called lateral or 
transverse chromatic aberration (TCA). If one has complementary coloured fringes 
progressively more from the centre to the corners, this is most likely transverse chromatic 
aberration. This type:  

·  can be corrected by software  
·  does not change by stopping down.  
·  is dependent from focus distance.  

 Chromatic aberration should be corrected if visible otherwise, at least for full screen or 
printed panoramas where you allow to zoom in to the native camera resolution. While 
correction is relatively easy CA can not be automatically determined like for example barrel 
distortion. Only visual judgement can give you enough control of the outcome. Unfortunately 
one needs some experience to do this. 
 

 
 
 
 
 Special lens systems (achromatic or apochromatic doublets (Fig. 4.2-10)) using two or 
more pieces of glass with different refractive indexes can reduce or eliminate this problem. 
However, not even these lens systems are completely perfect and still can lead to visible 
chromatic aberrations, especially at full wide angle. 
 On the basis of “The focal Encyclopedia of Photography” [16], Newton, in 1666, gave 
the cause of chromatic aberration in binoconvex lenses (used in camera obscura) and he 



Generation of a virtual tour in the 3D space applying panoramas, exercised on the sites of Dresden and Cracow 

 
 

 Karol Kwiatek, AGH University of Science and Technology, Cracow 2005  48 

Fig.4.2-11: Helmut Dersch’s third degree polynomial 

believed that this problem has no solution. The first achromatic lens was produced in 1757 by 
John Dollond. He demonstrated an achromatic lens that was a combination of a negatives lens 
and a positive lens of flint and crown glass. 
 
How to correct? 
 
 According to the panotools.info [9], in many cases it would be enough to adjust the 
size of the colour channels to correct for TCA. However, correction might not always be 
satisfactory even if it is of the true TCA type. This might have different causes:  

o There might be a rest of LCA in the image. In this case one or two colour channels can 
be blurred.  

o Images where JPEG compressed (too much). If one shift the colour channels of 
previously JPEG compressed images you emphasize the jpeg artifacts. It is a better 
idea to work on TIFF images converted directly from RAW or scanned directly.  

o Adjustment is too coarse. Depending on the resolution of the image sub-pixel 
alignment might be necessary.  

 
Easy way of correction 
 
 The most convenient way to correct TCA is to use a tool like the Adobe Raw 
Converter, Picture Window Pro or PTLens offer. One zoom into a corner and use a pair of 
sliders to adjust the image size for the red channel (red-cyan fringes) and the blue channel 
(blue-yellow fringes - the purple-green type is a mixture of red-cyan and blue-yellow type). 
Both ways allow for sub-pixel adjustment. This technique (including sub pixel adjustment) 
can be performed by hand with any image editor that can make size adjustments to single 
channels. If the step size is too large, the image can be upsampled prior to correction. 
However, if one uses one of those easy approaches, look closely at different areas of the 
image - especially different distances from the image centre. It could easily be noticed that 
correction in one area causes fringes in another one. If this is the case, TCA in this image does 
not follow an easy linear scheme and hence can not be corrected in this way (see precise way 
of correction).  
 
Precise way of correction 
 
 Panorama tools Radial Shift filter allows for separate correction of red, green and blue 
channel using a third degree polynomial. This kind of curve should be complex enough to 
correct for any kind of non-linear TCA.  
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Fig.4.2-12: Jim 
Watters’s  

research photograph 

 DERSCH [21] described in 1999 a trial of correcting chromatic aberration in images 
taken from scanning back cameras. One of these cameras is PanoScan. In the centre of the 
image, the three colour channels RGB coincide, whereas at the top and bottom the red and 
blue channels get shifted by a couple of pixels horizontally (Fig. 4.2-11). He suggested 
Panorama Tools and Correct submenu to correct images. Then he determined the horizontal 
shift dx between the colour channels in the scan. Calculation of the y-coordinate is rather 
complicated. He chose an algorithm that makes the coefficients useable for any scanning 
resolution. First, he determined the distance of the pixel from the centre line. This is the 
absolute y-coordinate ya. Then he determined the relative y-coordinate yr, which is ya divided 
by half of the height. Then he calculated b-values for red and blue using the equation b = dx / 
(yr*ya). This correction eliminated the error at the point that one has used for measuring dx 
precisely, but might fail on other points. Then one might try linear correction using c = dx / ya 
or cubic correction using a = dx / (yr * yr * ya). For his 
example quadratic correction worked best.  
 Unfortunately, this way of correcting colour separation 
does not fit to the panoramic images that were taken during the 
generation of the virtual tour using Eyescan MM1. Plenty of 
trials were made to estimate values for his equation, but 
without a good solution.  
 Until in the year 2004, WATTERS [22] from Canada and 
KRAUSE [23] from Germany found a way how to determine 
suitable correction coefficients using different calculation 
approaches.  
 They found a solution for normal and conventional 
photographs. Jim Watters also used Panorama Tools to correct 
chromatic aberration. Here is the example photo (Fig. 4.2-12) 
that he used in his research. In April 2004, he used fisheye lens 
(FC-E8) with his Nikon CoolPix995. After many trials and 
errors he found a way to determine values for nearly every 
lens. The formula (4.3) that he used is: 
 
 r_src = a X r_dest^4 + b X r_dest^3 + c X r_dest^2 + d X r_dest (4.3) 
 
where: 

o d values make linear changes to the image. 
o a,b, & c values make polynomial changes to the image. 
o The internal unit used for r_src and r_dest is the smaller of the width or height divided 

by 2. 
o With a=b=c=0 & d=1 the image will remain unchanged. 
o When a+b+c+d=1 the image width will remain unchanged. 

 
 He drawn circles to show how the image is effected with a, b and c parameters when d 
is also changed, such that d=1-a+b+c. What is more, he also drew graphs (Fig. 4.2-13 and 
4.2-14) to present how every parameters change the shape of the red net. Knowledge of the 
parameters changes, helps to correct images that were taken with digital panoramic camera 
Eyescan MM1. 
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Fig.4.2-13: How changes in d  
will effect the image 

Fig.4.2-14: How changes in a, b, & 
c will effect the image when d is also 

 modified to keep a+b+c+d=1 

Fig.4.2-15: At a first glance this panorama no. 33 does not show any CA 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Correcting chromatic aberration on the example of panoramic images taken with digital 
panoramic camera Eyescan MM1 and fisheye lens 8mm Nikkor. 
 
 This is a trial of correcting colour separation in spherical images. A solution for this 
problem was not found in the Internet. The following text in this chapter is written on the 
basis of correspondence with Jim Watters who was the first to found values for CA but for 
conventional images, not for panoramic images. The scope of chromatic aberration becomes 
visible by magnifying selected areas of the picture (Fig. 4.2-15). To do this, it is the best to 
select an area not from the centre of the picture (Fig. 4.2-16). This way, the magnified display 
will allow you to determine easily if the distortion travels horizontally, vertically or radially 
across the picture.  
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Fig.4.2-16: Magnifying specific area of the panorama no.33 
 shows chromatic aberration 

Fig.4.2-17: Correction of chromatic aberration via 
  Correct PanoTools filter for Photoshop 

Fig.4.2-18: The Radial-Horizontal shift is needed to 
 correct chromatic aberration errors 

 

 If the distortion is to be corrected in Adobe Photoshop with PanoTools filters, the 
PanoTools dialog box is invoked via Filter->Panorama Tools->Correct (Fig. 4.2-17). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 In the Set Polynomial Coefficients for Radial Correction dialog box (Fig. 4.2-18), the 
coefficients a, b, c and d can be entered selectively. To correct chromatic aberration, the 
values for red, green and blue must be selected with respect to the colour fringing offset.  
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Fig.4.2-19: TheRadial-Vertical shift is needed to correct chromatic 
aberration errors in panoramic images 

 In conventional photographs Radial Correction is enough to correct CA. But for 
panoramic images, especially spherical ones, using only this function is not enough. 
According to information included in correspondence from Jim Watters a new solution was 
found for panoramic images from digital panoramic camera Eyescan MM1. Images from this 
camera can not be corrected with a radial correction. A combination of horizontal (Fig.4.2-18) 
and vertical (Fig. 4.2-19) corrections is needed. Radial and Vertical correction differs from 
Horizontal. Radial and Vertical use the formula (4.4): 
 
 r_src = a X r_dest^4 + b X r_dest^3 + c X r_dest^2 + d X r_dest  (4.4) 
 
However Horizontal uses other formula (4.5): 
 
 delta_x = a X r_dest^3 + b X r_dest^2 + c X r_dest^1  (4.5) 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 In formula 4.4 the value d is ignored. For Radial r_src and r_dest are the smaller of 
width and height divided by 2. In this case of panoramic images, vertical resolution is smaller 
than the horizontal resolution and it has 3600 pixels. For Horizontal and Vertical r_src and 
r_dest are the height divided by 2. The last difference between (4.4) and (4.5) is that 
Horizontal is calculating a change in x (delta_x) but not absolute position.  
 There is a lot of trials and errors involved in estimating a,b,c and d values. These four 
values react differently. It is good to make a function “snapshot” in Adobe Photoshop. This 
feature is in the history pallet and is used to keep track of the different tests. Then it is 
advisable to write down what was done and compare the results with the next set. One should 
decide if the last correction makes it better or worse and if one should increase or decrease the 
change.  
 The first step of correcting panoramic images is to make sure that the optical centre of 
the image is the centre of the image. To do this one should crop or expand the image. Figure 
4.2-15 shows that the black area in not equal at the top and bottom of the image. One should 
crop this spherical panorama to have the same number of rows with black pixel at the top and 
at the bottom.  
 The second step is to magnify by two or three times the area of viewing. This is 
important for better seeing small shifts in the image. 
 Next step is to start correcting the image using “snapshot” function. One should start 
correcting image furthest from the centre. b values correct best the image at the top and 
bottom (furthest from the centre). But this correction did not favour the area between the 
centre and the edge. The area was away over corrected. Then a value tries to correct these 
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areas. This makes the image too overcorrected but now it is much closer. Then one should 
compensate them by adding a little reverse correction to b and c. Increasing a again is one of 
the latest step.  
 Finally one should fix any errors that remain between the edge and centre by fine 
tuning the remaining parameters. In tables (Tab. 4.2-1 and 4.2-2) are the corrections that fit to 
most of the spherical panoramas that were created during generation of the virtual tour of the 
TU Dresden campus. Only a few panoramas need a special treatment but these new values 
will be shown later.  
 

 a b c d 
Red 0.016 -0.001 -0.001 1 

Green 0 0 0 1 
Blue -0.016 0.001 0.001 1 

Tab.4.2-1: Horizontal correction 
 
 

 a b c d 
Red -0.0035 0 0 1.002 

Green 0 0 0 1 
Blue 0 0 0 1 

Tab.4.2-2: Vertical correction 
 
 Most of the spherical panoramas could be corrected using parameters from Table 4.2-1 
and 4.2-2. There were two panoramas that could not be corrected this way. Other values 
should be found. There were problems only with Panorama no. 5 and Panorama no. 6. 
Evaluating the values will be presented here on the example of Panorama 5 and 6. Both 
panoramas were made using fisheye lens. 
 
Panorama no. 5: 
 

o Shift red channel 1 pixel down and 1 to the left 
o Horizontal shift (Tab. 4.2-1) is then applied (d is not used in this correction)  

     Red:      a= 0.016;  b= -0.001;  c= -0.001; 
     Green:  a= 0;   b= 0;   c= 0;        

  Blue:     a= -0.016   b= 0.001;    c= 0.001; 
o These corrections almost correct the CA, but it looks like the image need a little more 

linear shift 
     Red:   a= 0.02;     b= -0.001;   c= -0.001;  
     Green:  a= 0;        b= 0;        c= 0;         

  Blue:     a= -0.02;    b= 0.001;    c= 0.001; 
o Last correction got rid of 60% of what was left so next time a little more should be 

corrected 
      Red:      a= 0.022;    b= -0.001;   c= -0.001; 
      Green:   a= 0;        b= 0;        c= 0;         
 Blue:     a= -0.022;   b= 0.001;    c= 0.001;  

o That got rid of the red/cyan CA but there is still a little yellow/blue  
     Red:      a= 0.022;    b= -0.001;   c= -0.001; 
     Green:   a= 0;        b= 0;        c= 0;         

  Blue:     a= -0.023;   b= 0.001;    c= 0.001;  
o That fixes the horizontal corrections. 
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Fig.4.2-20: Original and not corrected part of 
Panorama no. 33 

o Now Vertical corrections. (Tab. 4.2-2)  
    Red:      a= -0.0035;  b= 0;     c= 0;     d= 1.002; 
    Green:   a= 0;        b= 0;     c= 0;     d= 1; 
     Blue:     a= 0;        b= 0;     c= 0;     d= 1;    

o That fixed the vertical corrections. 
o There are still some minor shifts of less than 1 pixel present in different places on the 

pan. 
 

Panorama no 6: 
 

o Shift red channel 1 pixel down and 1 to the left 
o Horizontal shift should be applied: 

      Red:     a=0.022;   b=-0.001;  c=-0.001; 
      Green:   a= 0;        b= 0;        c= 0;         
  Blue   a=-0.022;  b=0.001;  c=0.001;      

o That correction did not correct the trees at the top at all.  Much more of a correction is 
necessary: 
     Red:    a=0.03;  b= -0.001; c= -0.001;  
     Green:   a= 0;        b= 0;       c= 0; 

         Blue:     a= -0.03;    b= 0.001;    c= 0.001;   
o Still not enough. Parameter a should be increased: 

   Red:      a= 0.04;     b= -0.001;   c= -0.001; 
     Green:   a= 0;        b= 0;        c= 0;         

  Blue:     a= -0.04;    b= 0.001;    c= 0.001;      
o Still not enough and now the area, between the centre and the edge, is over corrected.   
o Need less a and more of the reverse of b and c  

     Red:      a= 0.03;     b= -0.012;   c= 0.0012; 
     Green:   a= 0;        b= 0;        c= 0;  

        Blue:     a= -0.03;    b= 0.012;    c= -0.002; 
o Now it is time for vertical correction (Tab. 4.2-2): 
      Red:      a= -0.0035;  b= 0;     c= 0;     d= 1.002; 
      Green:   a= 0;        b= 0;     c= 0;     d= 1;  
      Blue:     a= 0;        b= 0;     c= 0;     d= 1; 
 That looks like it fixed the vertical. 

 
 It is advisable to save all correction 
values in different files so that all 
additional pictures taken with the same 
camera and lens can be quickly and 
accurately corrected.  
 In the four pictures that are below 
there is a presentation of a right correction 
that was done at every step. It is good to 
compare these four screen shots from 
Adobe Photoshop. Panorama no. 33 was 
taken in the courtyard near Georg-
Schumann building. Figures 4.2-20 - 4.2-
23 show the top part of the tower that 
belongs to this building.   
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Fig.4.2-21: After Horizontal correction 

Fig.4.2-22: After Vertical correction 

Fig.4.2-23: After Vertical Shift correction 
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Fig. 4.2-24: Vertical Shift – another submenu in Correct Options 

Fig. 4.2-25: Vertical Shift – the name of the box is incorrect  

 These pictures are a good example to show how to correct chromatic aberration. There 
are not only horizontal edges but even some vertical edges. The perfect example should be 
with black and white circles or stripes and it would be more contrasted image. What one can 
also find in the image are clock numbers and clock hands that are also enough contrast to 
show colour separation (Fig. 4.2-20). After Horizontal correction (Fig. 4.2-21) most of colour 
separation was corrected but not all of them. That is why Vertical correction (Fig. 4.2-22) is 
also important. All the previous function can be found in Radial Shift submenu (fig. 4.2-17). 
Vertical Shift can also be added to the image to correct a little vertical movement of the 
pixels. This Vertical Shift is another submenu (Fig. 4.2-24) that can be found as well as 
Radial Shift in Correct Options. 
 

 
 
 

 
 
 

By Vertical Shift (Fig. 4.2-25) a little shift of pixels could be linearly corrected. 
Moving all pixels one pixel down (in red channel) makes the image (Fig. 4.2-22) more clearly 
in magnification. The result is seen in Figure 4.2-23. 
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Fig. 4.2-26: Nadir of the spherical panorama displayed in SPi-V Viewer. 
When panning down, one sees the tripod. 

4.2.6. Nadir and zenith 
 
Nadir 
 
 In order to ensure a realistic depiction of a scene with spherical panoramic shots, it is 
usually necessary to edit the lower part of the picture (Fig.4.2-26). This is where the tripod 
legs or the feet of the photographer frequently can be seen. The best way to retouch the 
ground is to convert the spherical panorama into cubic format. This allows editing this 
specific area. In this place, a logo could be added. 
 

 
 
 

 
How to retouch a nadir? 
 
 There are at least two ways to do retouch a nadir. The first option is to manually edit 
the image in a graphics editing program. Adobe Photoshop's rubber stamp tool is great for this 
purpose. But it requires some effort to do it well. Another solution is to insert a logo, 
sometimes called a tripod cap. One simply pastes a logo (in a circular form) over the very 
bottom of the spherical panorama. This method is more suitable if one needs to produce many 
panoramas.  
 Before editing nadir and zenith one should change the aspect ratio of the spherical 
panorama. At first the resolution of the spherical panorama is 6126x3600 pixels. Vertical 
resolution depends only on the horizontal resolution. For example for panorama no. 18, after 
all process of controlling the seam and deleting of 16 pixels, the horizontal resolution is 
6254px. Dividing this value by 2, one gets 3127px (4.6).  
 
 6254 / 3127 = 2 / 1 (4.6) 
 
 The panorama no. 18 should be cropped to the resolution of 6254x3127px (aspect ratio 
of 2:1). The number of pixels could differ for every panorama. There could be a change of a 
few pixels. The target is to get the aspect ratio of 2:1. In Adobe Photoshop one should use 
Crop Tool in order to leave a few rows of pixels in the upper part of the image. More black 
pixels should be in the lower part of the image. The result after cropping is shown in Figure 
4.2-28 and could be compared with the original and not edited panorama (Fig.4.2-27). 
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Fig.4.2-27: Original panorama no.18 
before editing 

Fig.4.2-28: Panorama no.18 after 
cropping to aspect ratio 2:1, but 
before editing nadir and zenith. 

 
 
 
 
 
 
 
 
 
 

 
 
 
 
 Correcting nadir and zenith needs to install a new version of PanoTools. Because of 
patent problems with Ipix, Helmut Dersch limited field of view in PanoTools. One should get 
an updated (and unlimited) PanoTools from Jim Watters’s website [22] who now maintains 
this program. In version 2.7.0.10 dated at 14.05.2005 field of view is limited to 1000° and it 
enables to correct nadir and zenith using PanoTools 
 
There are a few steps to correct the nadir [24]: 

 
a. Open a spherical panorama (2:1) in Adobe Photoshop. The tripod is visible at the 

bottom. 
b. Write down the image size, because it will be necessary later (Image->Image size). 
c. Rotate the image 180° (Image->Rotate Canvas->180°). Now the tripod is at the top of 

the image (Fig. 4.2-29). 
 

 

 
d. Remove the bottom half of the image: Image-> Canvas Size. For “Height”, type 50 

and select “Percent”. For Anchor, select the top middle tile (Fig. 4.2-30). Click OK. 
One ends up with the top half (Fig. 4.2-31). 
 

Fig. 4.2-29. A rotated panorama no.18 
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e. Remap it to a vertical fisheye image: Filter -> Panorama Tools -> Remap. At first 
click “Prefs” button and change options to these shown on Fig. 4.2-32. Options (a), (c) 
and (d) should be disabled and in (b) one should choose the folder where new files 
will be saved.  
 

 
 

Fig. 4.2-30. Removing the bottom half of the panorama no.18 

Fig. 4.2-31. The bottom half of the panorama no.18  was removed 

Fig. 4.2-32. Preferences that should be set before remapping 
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The following options should be chosen when remapping (Filter -> Panorama Tools -> 
Remap) (Tab. 4.2-3): 

 
Convert from: PSphere 

Convert to: Fisheye Vert. 

HFOV(°): 360 

VFOV(°): 0 

 
 
 

f. One should open the image (Fig. 4.2-34) that was saved in the folder and now the 
tripod could be edited. Stamp Tool is necessary to edit a nadir. The result image is Fig. 
4.2-35. A logo could also be placed in the centre of the image. 
 

  
 

Fig. 4.2-33. Remap Options are used to convert images 

Tab. 4.2-3: Options used in remapping to Fisheye Vertical format 

Fig. 4.2-34. Remapped half of the 
panorama no.18 with a tripod 

Fig. 4.2-35. Remapped half of the 
panorama no.18 without a tripod 
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g. Once again remapping should be processed on the basis of the Table 4.2-4: 
 

Convert from: Fisheye Vert. 

Convert to: PSphere 

HFOV(°): 180 

VFOV(°): 0 

 
 

h. Close last edited image and open the result image from the folder. Match the size of 
the result to the original image (Image > Image Size), make sure that Constrain 
Proportions is enabled, and either correct the width (use the width of the original 
panorama in pixels). The bottom of the panorama without the tripod is shown in 
Figure 4.2-36. 

 

 
 
 
 

i. This image should be rotated, copied and pasted to the panorama with aspect ratio of 
2:1. 

j. A layer with pasted half of the panorama should be merged down. (Layer->Merge 
down). The result is shown in Figure 4.2-37. 

 

 
 

 
 
 
Zenith 
 
 It is also necessary to edit the upper part of the image. This is where almost always sky 
can be seen. The process is nearly the same as editing the nadir. There are a few differences: 

Tab. 4.2-4: Options used in remapping to PSphere format 

Fig. 4.2-36. The bottom half of the panorama no.18 without the tripod 

Fig. 4.2-37. The result image after editing a tripod (nadir).  
Now only zenith needs to be edited. 
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a. Open the last edited image (Fig. 4.2-27). 
b. Values have been written down. 
c. This rotating is cancelled in the process of correcting the zenith 
d. The process is the same. 
e-j. The process is the same. 
 

 Figure 4.2-38 shows the small “hole” in the shy. The zenith was corrected in the same 
way as the nadir. Only point c. should be cancelled. The final result after edition process is 
shown in Fig 4.2-39. The difference between 4.2-37 and 4.2-39 is the zenith in the upper part 
of the panorama presented as a black line (group of pixels). Displaying these panoramas will 
be discussed in the next chapter. 
 

 
  
 
 

 
 

 
 
 
 
 

Fig. 4.2-38. Remapped second half of 
the panorama with a hole in the sky 

Fig. 4.2-39. The final result of the spherical panorama  
after correction of the nadir and the zenith.  
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5. Displaying panoramic images and virtual tours 
 
 All panoramas are essentially image files, but viewing them in an interactive way is 
the result of combining the image and the capabilities of a viewer application. Some viewers 
can display panoramic pictures saved in familiar image formats such as JPEG, GIF or BMP 
while others use specialist file types designed specifically for VR use. The special formats 
contain the images themselves as well as instructions on how these pictures are to be 
displayed. These file types are associated with special viewer applications closely. For 
example the Apple QuickTime viewer uses the QuickTime movie format (.MOV) and the 
range of iSeeMedia viewers display the companies own .IVR-based pictures. The viewers that 
display standard image formats are mostly based on Java applets which as long as one has 
Java enabled in a Web browser can be viewed by most Internet surfers without the need for 
installing another plug-in.  
 
5.1. Presenting the completed project 
 
 Depending on the file format and viewer type used in the creation of a virtual tour, 
there are many possibilities of presenting the work. Mainly there are two ways of publishing 
interactive panoramas. One of them is to send the files of project to the Internet and the 
second is saving all the data on a CD or DVD. Before deciding the type of the viewer, any 
decision about the interface should be made. What is more, bandwidth of the Internet at 
viewer’s computer should also be considered.  
 
5.1.1. Designing the interface 

 
 The design of the interface is a critical part of creating the whole VR experience. Vast 
amounts of time and energy can be spent getting the panoramic images just right only to have 
the total effect let down by poorly designed or executed presentation pages. Many VR 
producers, realizing the complexities involved in quality Web production, have formed 
partnership with Web designers in order to stage their work.  
 
5.1.2. Bandwidth considerations 
 
 As with all content designed for the Web, file size determines the speed of display. 
High-resolution panoramas or complex VR tours can easily become too large to be 
downloaded and viewed conveniently by Web users with a standard modem connection. 
Because the only way to reduce the size of a panorama is to decrease their pixels dimensions 
or increase the level of compression. Creating a good VR production is a balancing act 
between image quality and file size. The panorama producer needs to be constantly aware of 
the size of content and the time it takes to download the panorama with different connection 
speeds. That is why, many VR sites contain a choice of differently sized versions of the same 
panorama to suit the variety of connection speeds. Viewers with modem connections can 
select a smaller, more compressed image while other users can choose a high-resolution and 
better-quality presentation. In addition to this choice, these sites often provide the content in 
multiple file formats that are suitable for several different types of viewer software.  
 The table below can be used to help predict the download speed of VR content with 
particular file size (Tab.5.1-1). 
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File size Download speed 

 14kBps  
(modem) 

28.8kBps 
(modem) 

56.6kBps 
(modem) 

128 kBps 
(DSL/Cable) 

30kB 24 secs 12 secs 6 secs 3secs 

100kB 76 secs 38 secs 19 secs 9 secs 

300kB 216 secs 108 secs 54 secs 27 secs 

1 MB 720 secs 360 secs 180 secs 90 secs 
Tab. 5.1-1. Download speed of VR content with particular file size [18] 

 
5.2. Panoramic viewers 
 
 According to panotools.info [9], there are basically three types of viewers for spherical 
panoramas: 

o Java based viewers run on any platform that supports Java.  
o Plug-in based viewers require a plug-in (QuickTime, Shockwave) to run and might be 

platform specific.  
o Stand alone viewers that are executables for a specific platform.  

 
 Java based viewers are for free. First and until now most versatile is PTViewer 
developed originally by Helmut Dersch and now maintained and enhanced by Fulvio Senore. 
The next free Java based viewer is Immervision G2. There is still beta version, but this viewer 
seems to be very promising.  
 QuickTime, PangeaVR and SPi-V are plug-in based viewers. Quicktime is available 
for Apple Macintosh and Windows. This program requires QTVR movie format. PangeaVR 
is a viewer for Mac OSX only that displays both cubic QuickTime-VR panoramas movie 
format and equirectangular (spherical) JPEG panoramas. The last viewer in this category that 
will be described in details later is SPi-V. This is a very sophisticated and smooth viewer 
based on Macromedia Shockwave that handles panoramas completely in graphic card 
memory.  
 Last group of viewers are stand alone viewers. They do not need any plug-in or Java 
installed on the computer. FSPViewer that will be also described later displays really big 
panoramic images and it is a free hardware accelerated viewer. Others viewers in this group 
are: panoglview, panoviewer, PTViewer (original stand alone viewer created by Helmut 
Dersch) and QuickTime (also works as a stand alone viewer).  
 To display the virtual tour of the Dresden University of Technology campus, one 
viewer from every group was chosen. The choice was not randomize, but after many 
selections SPi-V and FSPViewer were chosen to present the virtual tour. Java version was 
also created with help of PanoramaVision software from SASTAdigital from Berlin. 
 The problem before choosing the viewer was to find the best viewer for high-
resolution panoramic images that were taken with Eyescan MM1. The resolution of these 
images is even 27777x3600 pixels (for 28mm lens). The maximum file size for original 
images is up to 249MB. Those files can not be sent to the Internet. Those files could be only 
seen in FSPViewer (stand alone viewer that works on a local hard disk). For the Internet the 
best choice was SPi-V viewer, because of its handling with big and compressed images in a 
quick way.  
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5.2.1. FSPViewer 
 
 FSPViewer is a free viewer for cylindrical and spherical (equirectangular) panoramic 
images. The latest version 1.3 is dated on 28 July 2005. One can download this version from 
[25]. A few details will be described and some reasons for choosing this stand alone viewer 
will be mentioned. It is not a program for viewing panoramas in the Internet. FSPViewer is 
designed for viewing local (hard-disk, network or CD) high resolution panoramic images at 
fullscreen and with very high image quality. It uses advanced interpolation algorithms to 
show you smooth images without losing sharpness. Internet viewers are designed for 
displaying small images in small windows, since bandwidth is limited. Viewing a panorama 
in 1024x768 or higher size will give you a much more immersive feeling, but it will require 
much more resources from the computer. The whole image will be loaded in memory and the 
program will need to write a very high number of pixels, so a fast processor will be needed for 
smooth panning. FSPViewer can handle images limited only from the available RAM and is 
heavily optimized so it is fast enough on modern computers. FSPViewer runs on any 
Windows 32 bit operating system. It requires DirectX 7 or later, which is almost certainly 
already installed on every computer. The graphic card must be set to True Color (16 million 
colors). The program works in 24 and 32 bit modes, but 32 bit is noticeably faster. 
 
Displaying high-resolution panoramic images 
 
 At first displaying panoramas are described and then adding hotspots to make a virtual 
tour. This program does not need any installation. When one runs it, FSPViewer shows an 
empty window. To open a panorama one should select the File->Open menu command or 
press the Open button in the toolbar. The program can open JPEG, TIFF or FSV control files 
that are described below. One can navigate in an image by dragging the mouse or pressing the 
arrow keys. Pressing the A key or the SHIFT key changes zoom in, pressing the Z key or the 
CONTROL key changes zoom out. There are three kinds of interpolator that are used in 
presenting panoramas. Fulvio Senore [25], the author of this program, writes that all 
panoramic viewers work in the same way: they load an image in memory and use the pixels of 
that image to compute the different views that you see on the screen. Every pixel on the 
screen maps to a position between the pixels of the base image. While panning, FSPViewer 
will take the nearest pixel in the base image and show it on the screen. This is the fastest 
option and is used to obtain a smooth panning, but it yields to poor quality. For this reason the 
program will compute a higher quality image as soon as you stop panning. FSPViewer 
implements three different algorithms: each one trades quality for speed at different extents 
and you can choose which one to use with the Tools->Options menu command (Fig. 5.2-1).  

 
o None (Fig. 5.2-2) - does not use any interpolator. 

It is the fastest options but image quality is low. 
o Bilinear (Fig. 5.2-3) - uses 4 pixels in the base 

image in order to compute each pixel on the 
screen. It is very fast, but the resulting images 
are a little blurred. This is the only interpolator 
that is used (if any) in most viewers. 

o Lanczos2 (Fig. 5.2-4) - is a two-lobed Lanczos 
windowed Sinc filter and uses 16 pixels in the 
base image for each pixel on the screen. It is 
slower but creates high quality images. This is 
the default setting. 

Fig. 5.2-1. Options of interpolators in FSPViewer 
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o Lanczos3 (Fig. 5.2-5) - is a three-lobed Lanczos windowed Sinc filter and uses 36 pixels 
in the base image for each pixel on the screen. It is relatively slow but it creates the highest 
quality images. 
 Here are examples (Fig. 5.2-2 – 5.2-5) of the result of the various interpolator options. 
The zoom level is 930%. This sign “2.8t” is from Panorama no. 21. 
 

                     
 
 

                      
 

Fig. 5.2-2. No interpolator Fig. 5.2-3. Bilinear interpolator 

Fig. 5.2-4. Lanczos2 interpolator Fig. 5.2-5. Lanczos3 interpolator 
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 As one can see, without interpolation the lines are jagged and distorted but the image 
looks sharp. This is why many people prefer this setting to bilinear. Bilinear interpolation 
renders smooth edges but creates a blurred image. Lanczos interpolators render smooth edges 
and sharp images. This is a very good result, but it has a very high computing cost: only 
modern computers can compute it fast enough to use it an almost real-time application. 
 
Displaying high-resolution virtual tours 
 
 FSPViewer can directly open the JPEG of TIFF image file of the panorama, but one 
may want to use more advanced features of the program, such as hotspots. In order to use 
these features one must supply more information to the program. This is accomplished by 
writing a control file for each panoramic image. The control file has a default extension of 
FSV and is a text file written according to some guidelines [25]. Each line contains a key and 
a value, separated by an equal sign (=), without spaces. The keys are not case sensitive. 
 

 
- A name of the JPEG file to open. 
- A text that appear in the title bar of the 

window. 
- A comment. 
- A hotspot’s section starts here. 
- Specifies the x coordinate of the hotspot. It 

is computed as the absolute x coordinate of 
the pixel divided by the width of the image 
and multiplied by 100. The resulting value 
will be between 0 and 100. This may seem 
complicated, but the result will not change 
as you resize the image. 

- Specifies the y coordinate of the hotspot. It 
is computed as the x coordinate. 

- Specifies a description of the hotspot to be 
shown in the status bar. 

- Specifies the name of the file to be opened 
when clicking the hotspot. 

- Specifies the yaw (horizontal angle) for the 
opened panorama.  It must be between 0 
and 360. 

- Specifies the pitch (vertical angle) for the 
opened panorama.  It must be between -90 
and 90. 

- Specifies the horizontal field of view for 
the opened panorama. It is an angle and 
must be less than 70 degrees. 

- This line closes hotspot’s section. 
 

 
 
 
 With FSPViewer one can define hotspots inside the FSV control file (Tab. 5.2-1). One 
can specify the viewing direction and angle of view of the opened panorama, in order to 

ImageName=15.jpg 
WindowTitle=Panorama 15 
 
// Panorama 15 
begin hotspot 
 x=65.75 
 
 
 
 
 
 
 y=48.37 
 
 description=Panorama 14 
 
 target=14.fsv 
 
 initialYaw=262.82 
 
 
 initialPitch=3.13 
 
 
 initialHPov=45.0 
 
 
end hotspot 

Tab. 5.2-1. 15.fsv – a code (panorama 15) 
describing the position of one hotspot to panorama 

14 
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create immersive virtual tours. Each hotspot is defined by a number of consecutive lines in the 
FSV file. The first line must be "BEGIN HOTSPOT" and the last must be "END HOTSPOT". 
The result of placing the hotspot on Panorama no.15 to Panorama no.14 is shown on  
Fig. 5.2-6. 
 

 
 
 
Yaw and pitch 

 
 
 In order to compute these values you need to open the target panorama with an image 
editor (for example Adobe Photoshop) and take note of the coordinates of the point where you 

Fig. 5.2-7. Coordinates of yaw and pitch angle use this scheme 

Fig. 5.2-6. The hotspot defined in Tab.5.2-1 
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want to look. Coordinates of yaw and pitch angle use the scheme presented in Figure 5.2-7. 
Let w be the width of the image, h its height, x and y the coordinates of the point (5.1). 
 
 InitialYaw = (x*360)/w (5.1)  
 
Its values are between 0° (left) and 360° (right). 
 
 InitalPitch = 90*(h/2 - y)/(w/4) (5.2)  
 
One will obtain a number between -90 and 90: negative values mean "look down", positive 
values mean “look up” (5.2).  
 
Creating a virtual tour on a CD/DVD 

 One can create a CD to show the virtual tour to other people using FSPViewer. The 
CD will not require installation and it will work on almost every Windows computer. 
FSPViewer also runs on Linux computers using WINE. The method to do this is to copy 
FSPViewer.exe and panoramic images to a CD. It is better to use JPEG images than TIFF 
ones. TIFF images are so large that loading them from a CD takes lots of time. To see the 
panoramic images just run FSPViewer and open the desired file. One can create an autostart 
CD that will automatically open the first panoramic image in virtual tour when inserted in a 
computer. A text file named AUTORUN.INF containing the following three lines should be 
added to the CD (Tab. 5.2-2). 

 

 
 
 
 
 
 The “-s” switch forces FSPViewer to show “*.fsv” files in the file open dialog, so 
users will not open the underlying jpeg files losing the information contained in the control 
file.  
 FSPViever is a good viewer for really big images. There are of course some 
disadvantages of using this program in viewing panoramic images and as well virtual tours. 
Firstly, the process of calculating the InitialYaw and InitialPitch are really time-consuming. 
One should open an image editor and then write down all values and then change them to the 
necessary values. In creation of the virtual tour for the Dresden University Campus this 
calculations were done in Microsoft Excel. Secondly, the interface is not as interesting as SPi-
V viewer has (see next chapter). However displaying huge TIFF images is an advantage of 
this program. One could check the seam while editing panoramic images. This viewer was 
helpful during the process of cutting “16 columns of pixels” for every panorama. 
 
5.2.2. SPi-V viewer 
 
 This viewer uses a file format that requires a plug-in to be installed on the end user’s 
machine. Creating the virtual tour one risks that those users do not have the plug-in. There are 
also some users who can not download the plug-in (perhaps because of a firewall) or who do 

[autorun] 
OPEN=FSPViewer.exe 1.fsv -s 
ICON=FSPViewer.exe,0 

Tab. 5.2-2. A code of autorun.inf 
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not want to (perhaps they do not know how or are worried they will mess up their computer 
by doing so).  
 SPi-V (short for Shockwave Panorama Viewer) is Aldo Hoeben’s program. This 
viewer was chosen for the virtual tour of the TU Dresden campus, because of a few reasons: 

o High fidelity, anti-aliased graphics; 
o Full screen, silky smooth navigation; 
o Fully interactive user interface and hotspot capabilities; 
o Highly customisable branding options; 
o Full, 8 bit transparency support; 
o Compatible with Microsoft Windows (98 and up) and Apple MacOS (9.X and OSX). 

 
 Aldo Hoeben writes on his webpage [26] that SPi-V can be used both online and 
offline. When used online, SPi-V benefits from Shockwave's considerable player adoption. 
Offline things look even better, as no install is necessary to run the SPi-V standalone viewer 
off a CD. Even though SPi-V is capable of displaying exciting new effects inside panoramic 
scenes hardware requirements are low, allowing a wide audience to enjoy engaging content. 
System requirements are the following: 

o Macromedia Shockwave version 10 or newer plug-in; 
o Hardware accelerated 3d card (16 Mb Video RAM, 32 Mb or more recommended); 
o Display set to 32 bit for best performance. 

 SPi-V is the first hardware accelerated panoramic viewer engine available to wide 
audience, although it is something like PTViever: a Java applet that does not run on Java, but 
Shockwave.  

 
 
 

 According to the NPD Online survey, conducted June 2005, Macromedia Shockwave 
Player reaches 55.4% of Internet viewers (Fig. 5.2-8). The most popular content is 
Macromedia Flash™ Player. Java (86.5%) and Apple QuickTime Player (64.1%) that are 
used for viewing panoramic images, are more popular than Macromedia Shockwave Player. 
Though that, it is worth to install Shockwave Player on the computer and to see the amazing 
results of this plug-in. 
 Landis Bennett, one of the World Wide Panorama organizers [26], found SPi-V to be 
“an extremely powerful panorama viewer that he believes that it will revolutionize the field of 
VR Photography. The smooth panning and gentle stops really amaze with this viewer. But a 

Fig. 5.2-8. Macromedia Shockwave content reaches 55.4% of Internet viewers [27] 
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smooth viewing of a panorama is not the only think; Aldo continues to come up with new and 
innovative things to do with SPi-V”. 
 In Michelle Bienias’s article in VRMAG titled “Aldo Hoeben’s SPi-V engine” 
(January 2005) [28] there are clearly explained features of this viewer. He writes that one of 
the big advantages of SPi-V is the use of XML. What is more, by using XML format and 
separate graphics files, SPi-V itself is a modern viewer. XML is much like HTML. There is 
no WYSIWIG (“What you see is what you get”) editor for SPi-V yet, but Aldo Hoeben is 
thinking about this tool. Now virtual tours have to be edited in a text editor using XML.  
 Four licenses of SPi-V are available. One of them is free, if the branding name 
(fieldOfView) is visible while the panoramas are displayed (Fig. 5.2-9).  
 

 
 

 
 
 
First steps with SPi-V [26]: 
 
  SPi-V can show images in different panoramic projections:  

o Flat images, also known as rectilinear 
o Cubic images 
o Cylindrical images 
o Spherical images 

 SPi-V can display panoramas in the browser, but there is also an executable version 
available that works outside the browser. This viewer is available for both Windows 
(Windows 98 and newer) and OS X (version 10.2 and newer). The stand alone viewer is 
essentially the same as the browser version; it can open panoramas in either simple or xml 
mode. One can drop simple panoramas in JPEG, GIF, PNG or BMP format on the application 
icon, or SPi-V xml files.  

Fig. 5.2-9. SPi-V viewer (free version)  includes fieldOfView  
branding in the bottom right corner 
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 The virtual tour of the Dresden University of Technology campus is available in the 
Internet. Www.kwiatek.krakow.pl/panotour (Fig. 5.2-10) is the main web page of this virtual 
tour. Further the internet address could be changed so please refer to the author’s webpage: 
www.kwiatek.krakow.pl and a new link to the virtual tour must be there. 
 

 
 

 
 
How to run the internet version of the virtual tour of the Dresden University of Technology 
campus? 
 
 The example of running the internet version of the virtual tour is presented using 
Mozilla Firefox browser. Using other web browsers there could be different options at the 
beginning but all the process of installing Shockwave Player is very similar. 
 

o Open a browser (here Mozilla Firefox version 1.0.6) 
o Enter this internet address: http://www.kwiatek.krakow.pl/panotour 
o In the menu on the left there are three versions of the virtual tour: 

�  VT HI-RES (High Resolution Virtual Tour) – vertical image size: 1024 pixels; 
file size: 300kB – 1,5MB (depends on the lens used in the project) 

�  VT LO-RES (Low Resolution Virtual Tour) – vertical image size: 800 pixels; 
file size: 80kB – 500kB (depends on the lens used in the project) 

�  VT-JAVA (Java based Virtual Tour) – this virtual tour uses Java and was 
designed in program from SASTAdigital – PanoramaVision (will be described 
later). 

o Macromedia Shockwave Player 10 is necessary to run VT HI-RES and VT LO-RES. 

Fig. 5.2-10. The interface of the virtual tour –  
www.kwiatek.krakow.pl/panotour [status: 28.08.2005] 
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o Click VT HI-RES (only for fast Internet connection) or VT LO-RES (for slower 
Internet connection) and the beginning message will be shown (Tab. 5.2-3): 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

o Click START (when one has Shockwave Player 10 installed the virtual tour will start 
otherwise a little installation process is necessary to “walk through” the campus 
(Fig.5.2-11)). 

 

 
 
 

o Click Install Missing Plugins. The window (Fig. 5.2-12) will appear: 
 

 
 
 

High - resolution plug - in Virtual Tour  
 

To view this virtual tour you will need the  
Macromedia Shockwave plugin   

and a recent video card (16 Mb Video RAM required, 32 Mb recommended).  
If you are using Internet Explorer on Windows, or the Firefox browser,  
try pressing F11 to fill the full screen. Press F11 again to return to 

a normal window. 
On Mac OS X, the best results are achieved using the Firefox browser.  

If you have problems, please close browser's window and run it once 
again. This solution should help! 

 
Please wait a while after you click START !!! 

 
S T A R T  

 

Fig. 5.2-11. Downloading plug-in is necessary to “walk through” the campus. 
 

Fig. 5.2-12. Macromedia Shockwave Player 10.1 needs to be installed 
 

Tab. 5.2-3. The beginning message 
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o Then one needs to agree to install Macromedia Shockwave Player 10. 
o After this Mozilla Firefox is installing the plug-in. 
o Choose the language 
o Then the installer will inform that the plug-in was installed for all the viewers that one 

has on the computer (for example for Internet Explorer) 
o In next step it is important not to agree for installing Yahoo! Toolbar. Leave the small 

box empty (Fig. 5.2-13) 
 

 
 
 
 

o After a while the installation process is almost completed. 
o Before full success of installation one needs to answer a question about the age and 

register the plug-in. Leave the circled box empty (Fig. 5.2-14) not to received 
additional e-mail. 

 

 
 
 
 
o Mozilla Firefox needs to be restarted for the plug-in to work. 
o Once again enter this address: 
  www.kwiatek.krakow.pl/panotour and choose the version of 
 the virtual tour. 
o This sign (Fig. 5.2-15) will show that the virtual tour is 

loading. Please wait a while, because the first image in the 
virtual tour needs to be loaded. 

Fig. 5.2-13. Installing Yahoo! Toolbar will add a new toolbar for your browser and 
this is not necessary so it is advisable to leave this box empty 

 

Fig. 5.2-14. One question and registration of the plug-in are necessary to complete 
installation process. Leave the circled box empty. 

 

Fig. 5.2-15. Shockwave’s loading bar 
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How to run the virtual tour of the Dresden University of Technology campus on the hard 
disk? 
 

o Open the folder on the CD-ROM or DVD-ROM 
o Open file !!!.BAT that contains the following line (Tab. 5.2-4): 

 
 
 
 
 
 SPi-V.exe  – SPi-V viewer 
 -f               – runs the virtual tour in fullscreen mode 
 tour22.xml – the latest version of xml file (it could have a different name) 

 
o The first time one launches the viewer, it may need to download some additional 

Shockwave components (Fig. 5.2-16).  

 

 
Embedding the SPi-V’s virtual tour in a HTML page 
 
 To embed the SPi-V engine in a webpage, one needs to invoke the shockwave player 
and let it “play” the SPi-V engine DCR file. The SPi-V.DCR file needs couples of specific 
parameters set, which are outlined below. A basic html snippet invoking the SPi-V engine is 
shown below (Tab. 5.2-5) (the most important parts in bold): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

<object classid="clsid:166B1BCA-3F9C-11CF-8075-444553540000" codebase= 
http://download.macromedia.com/pub/shockwave/cabs/director/sw.cab#version
=8,5,1,0 width="100%" height="100%"  > 
 
  <param name="src"            value=" SPi-V.dcr "> 
  <param name="swURL"          value=" tour22.xml "> 
  <param name="swStretchStyle" value="stage"> 
  <param name="progress"       value="TRUE">  
  <param name="logo"           value="TRUE">  
  <param name="bgColor"        value="#000000"> 
 
  <embed width="100%" height="100%"  type="application/x-director" 
    pluginspage="http://www.macromedia.com/shockwave/download/" 
    src=" SPi-V.dcr " swURL=" tour22.xml " swStretchStyle="stage"  
    progress="TRUE" logo="TRUE" bgColor="#000000"> 
  </embed> 
</object> 
 

Fig. 5.2-16. SPi-V needs to install some additional Shockwave components. 
 

SPi-V.exe -f tour22.xml 

Tab. 5.2-4. A code of !!!.BAT 

Tab. 5.2-5. A code of index.html at www.kwiatek.krakow.pl/panotest 
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A simple SPi-V XML document 
 
 The virtual tour of the campus (tour22.xml) consists 2134 lines (about 55 pages) of 
code that was written in the text editor like Notepad or editor for HTML that coloured the 
code. It is difficult to present all the details of creating this file that is the main part of the 
virtual tour. Only the basic rules of creating XML files for SPi-V will be presented below 
(Tab. 5.2-6). More information can be easily found on [16]. 
 
 
 
 
 
 
 
 
 
 
 
 

 XML documents (Tab. 5.2-6) look a lot like HTML, but there are a number of subtle 
but important differences:  

o All XML elements must have a closing tag, and must be properly nested. 
o When writing any XML document, special care should be taken that all tags must 

either have a corresponding closing tag (eg <tour> ... </tour>) or specifically close 
themself (for example <panoelement ... />).  

o XML tags are case sensitive. 
This line in tour22.xml is for implementing the user interface.  
<uigroup src="toolbar/toolbar.xml"/> 
What is more, this code (Tab 5.2-7) adds information about images that are hot-spots on the 
map. For example there are three types of the same image (normal image, hover image – the 
mouse is over the hot-spot and press image – this image activates when the hot-spot is 
clicked). The similar situation is with hot-spots on the panoramas (Tab. 5.2-8). 
 
 
 
 
 
 
 

 
 
 
 
 

<?xml version="1.0"?> 
<tour> 
  <scene id="scene_panoramic"> 
    <meta> 
      <title>panoramic</title> 
      <description> A description of the panorama </description> 
    </meta> 
    <panoelement id="pano_panoramic" image="image_panoramic" /> 
    <image id="image_panoramic"> 
      <layer type="bitmap" src=" panoramic.jpg " /> 
    </image> 
  </scene> 
</tour> 
 

Tab. 5.2-6. A basic example of code of XML file that is necessary for SPi-V 

<image id="dot" width="11" height="11"> 
      <layer class="base" type="matte"  color="FF0000" 
alphatype="bitmap" alphasrc="common/dot-filled8.gif"/> 
      <layer class="hover" type="matte" color="FFFF00" 
alphatype="bitmap" alphasrc="common/dot-filled8.gif"/> 
      <layer class="press" type="matte" color="000000" 
alphatype="bitmap" alphasrc="common/dot-open8.gif"/> 

Tab. 5.2-7. Implementing hot-spots on the map 
<image id="hs">  
<layer class="base" type="matte" color="FFFFFF" 
alphatype="bitmap" alphasrc="common/logo1_64.gif"/> 
<layer class="hover" type="matte" alphatype="bitmap" 
color="FFFFFF" alphasrc="common/logoT_64.gif"/> 
</image> 

Tab. 5.2-8. Implementing hot-spots on the panoramas 
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This is the fragment of the code that shows the map (Tab. 5.2-9): 
 
 
 
 

It is important to save the image as a PNG file. 
 There are 53 panoramas (53 scenes) included in the project of the virtual tour. There 
are two different projections: cylindrical and spherical. All details must be defined in the 
XML file for every panoramic image. Below (Tab. 5.2-10), there is an example of one scene 
(scene 14) that consists a spherical panorama. Some important lines will be described under 
this table.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Lines 1-6 in (Tab. 5.2-10) consist of text that defines the panorama made with fisheye lens. 
For 14mm lens this text should look like (Tab. 5.2-11): 
 
 
 
 
 
 
 
 
 

 

1 
2 
3 
4 
5 
6 
7 
 

8 
9 
 

10 
 

11 
12 

 
13 
14 

 
15 

 
 
 
 

16 

<uielement id="op-map" zorder="2"> 
        <image id="op-map-img"><layer class="base" type="bitmap" 
src=" map/ver1111111.png "/></image> 
      </uielement> 
 

Tab. 5.2-9. Implementing a transparency map to the virtual tour 

<!-- SCENE 14 = FishEye --> 
<scene id="scene14"> 
<meta> 
<cameralimits fovmin="10" fovmax="60" /> 
</meta> 
<panoelement id="pano" type="spherical" hfov="360" vfov="180"> 
<image id="image"><layer class="base" type="bitmap" 
 src="tour/14.jpg"/></image> 
</panoelement> 
<panogroup id="gr1" zorder="3"> 
 
<panoelement id="hotspot144" type="flat" hfov="4" pan="77" tilt="2" 
 image="hs" > 
<behavior> 
<action event="release" type="setView" scene="scene4" pan="173" 
 tilt="3"/> 
</behavior> 
</panoelement> 
[. . .] 
</panogroup>  
[. . .] 
</scene> 

Tab. 5.2-10. One of the scene no.14 in the tour22.xml 

<!-- SCENE 16 = 14mm --> 
 <scene id="scene16"> 
<meta> 
      <cameralimits  
        panmin="-180" panmax="180" 
        tiltmin="-44" tiltmax="44" 
        fovmin="10"  fovmax="60" /> 
</meta> 
<panoelement id="pano" type="cylindrical"> 

Tab. 5.2-11. The top part of scene no.16 in tour22.xml that is characteristic only for 
panoramic images made with 14mm lens. 
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And for 28mm lens the top text should be like this on the example of scene no.22 (Tab.5.2-
12): 
 
 
 
 
 
 
 
 
 

 One should define firstly in the scene what kind of panoramic image will be displayed. 
Determining the right values for cameralimits  (camera limits) are important to show the 
proper part of the environment around the view position. The values are different for different 
lens used. In the 7th line (Tab. 5.2-10) one must put the name of the panoramic image that 
should be displayed in that scene. In the 10th line in the same table there is a definition of the 
hot-spot to panorama 4 (“hotspot144” means that this is a hotspot from panorama 14 to 
panorama 4). This hot-spot uses the images from the fragment of the code presented in Tab. 
5.2-8. Pan and Tilt is the place where the hot-spot should be placed in the panorama. One 
could get these values (in degrees) using Aldo Hoeben’s program that is called SPi-V Spotter 
(Fig. 5.2-17). 
 

 
 

 

<!-- SCENE 22 = 28mm --> 
 <scene id="scene22"> 
 <meta> 
      <cameralimits  
        panmin="-180" panmax="180" 
        tiltmin="-26.5" tiltmax="26.5" 
        fovmin="10"  fovmax="40" /> 
    </meta> 
<panoelement id="pano" type="cylindrical"> 

Tab. 4.2-12. The top part of scene no.22 in tour22.xml that is characteristic only for 
panoramic images made with 28mm lens. 

Fig. 5.2-17. SPi-V Spotter helps to determine pan and tilt (panorama no.51) 
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 The red pointer (Fig. 5.2-17) is used to point the place where one would like to have a 
hot-spot. Shift and Control keys can be used to change the field of view.  
 In the 12th line (Tab. 5.2-10) there is a code that makes an action after one clicks the 
previously defined hot-spot. The new panorama no.4 will start with set values. This is in order 
to get a real experience of the user of the virtual tour. Virtual tour using panoramic images 
must behave in such way that the user does not fell confused. The direction of viewing should 
be adequate when going through the virtual tour. Line number 16 (Tab. 5.2-10) is the last line 
in the scene. Special xml tag </scene> ends this section in file tour22.xml. The last line in 
this file is tag </tour>  that ends the xml file. 
 First version of SPi-V was released in November 2004. Now there is version 1.3 [26]. 
Hoeben says in the interview with the reporter from VRMAG [28] that animated images and 
flash based textures are next step to add to his viewer. SPi-V 2.0 should include support for 
huge panoramic images. SPi-V viewer was originally developed for off-line (CD-ROM) and 
broadband delivery of rich panoramas. It offers amazing possibilities. Advantages of this 
viewer are high performance and high quality. There are also some disadvantages such as 
downloading plug-in and performance depends on 3D hardware.  
 
5.2.3 Panorama Vision and Java based viewer 
 
 SASTAdigital is a company from Berlin from Germany. It is also a producer of two 
digital panoramic cameras: DRS 3000-C and DRS 5000. DRS 3000-C produces a colourful 
panorama with the resolution of 3.648 x 22.500 pixels and DRS 5000 makes a black and 
white panorama with much more better resolution such as 5.000 x 30.000 pixels.  
 PanoramaVision is also a product of this company and it was provided free of charge 
to the author of this diploma thesis. The virtual tour through the campus in Dresden was also 
created with this program and some comments about possible improvements were sent to the 
author of PanoramaVision – Mr Karsten Knothe. 
 PanoramaVision is software for linking panoramas to get a virtual tour. The use of the 
software is fast and can be provided without previous knowledge. Already existing picture 
series can be further used. In this program existing panoramas from the campus were used.  
 
Preparation of the data for PanoramaVision [29,30,31]. 
 
 Firstly every panorama needs to be resized. The vertical resolution should be resized 
from 3600 pixels to 300 pixels. The horizontal resolution is different for different lenses. It is 
advisable to build an action in Adobe Photoshop with resizing and saving as JPEG function.  
There are a few steps to make a virtual tour in this program: 

o Click this icon  to start a new project. 

o Click  to add a map to the project; the same map as used in SPi-V viewer 
 is used, but it must be converted to JPEG (ver1111111.jpg). 
o One will see this window (Fig. 5.2-18). 

o Now one could add panorama standing point by clicking this icon  and then the 
red point will be shown on the map; to add a panoramic image to this point one should 

click  in the right menu.  
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o To show the basic function of this program one should use more than one interactive 

points on the map in order to link them; example (Fig. 5.2-19) shows loaded two 
panoramic images – one cylindrical and one spherical. 

 

 
 
 
 

o This icon  makes easily the connection between panoramas. 
Firstly, one can click the first yellow point and then the second. In a 
while a new window (Fig. 5.2-21) appears and one could define the 
viewing directions. After this a big red arrow is visible on the map 

(Fig. 5.2-20). 

Fig. 5.2-18. PanoramaVision after adding a map to the project 
 

Fig. 5.2-19. PanoramaVision after implementing two panoramic images;  
the selected area is responsible for setting a starting field of view 

 

Fig. 5.2-20. Linked 
panoramas 
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o Next step of generation of interactive virtual tour is to make hot-spots of places of 
interests that the creation is shown in Fig. 5.2-22. Firstly one should choose this icon 

 or   to select the area of interests. Then one could make a html web page with 
a photo and information about that building or monument.  

o The project is finished when all points are connected and all panoramas are included. 
To change the size of the viewer in the Internet on a webpage one should click this 

icon . To save the project – this icon  and specify the name of the 
xml file.  

o Completed project is shown in Fig. 5.2-23. All of 53 panoramas from the campus are 
linked. The result is a file pano_dd1.xml and other folders with panoramic images, 
html webpages, pictures and drawings added during generation of the virtual tour. 

 

Fig. 5.2-21. In PanoramaVision one can easily define the viewing directions. 
 

Fig. 5.2-22. The process of creating hot-spots of places of interests. 
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o Last step is to publish this file in the Internet. One should create html file that consist 
the following code (Tab. 5.2-13). The most important part is bolded. The first applet is 
responsible for the viewer and the second – for the map with hot-spots. 

 
 
 
 
 
 
 
 
 
 

 
 There are several advantages of this program: 

o quick method of creating a virtual tour with many panoramic images 
o easy way of creating hot-spots 
o easy way of generation of viewing directions 
o XML code 
 
And there are a few disadvantages: 
o it is not yet possible to add hot-spot on spherical panoramas. 
o adding animated GIF to hot-spots is not implemented 

 
 It is difficult to compare those three panoramic viewers that are used for different 
purpose. The first one is a stand alone viewer – FSPViewer. It is the best for panning huge 
panoramic images. The second one – SPi-V is the plug-in viewer that gives the user nearly 
infinite number of ideas that can be implemented to the virtual tour. Contact with the author 
of this viewer is well done by a forum on his webpage [26]. The last viewer that is based on 
Java – does not create an amazing performance of virtual tours but panoramic images are easy 
to download and to can be displayed even when the computer is connected via modem. Java 

Fig. 5.2-23. The completed project of the virtual tour of the campus saved as pano_dd1.xml 
in PanoramaVision and the file displayed in the browser 

 

  <div align="center"> 
<applet name="viewer" archive=" pva.jar " 
code="pviewer.pviewer.class" width="400" height="300" 
mayscript=true> 
   <param name="datafile" value=" pano_dd1.xml "> 
   <param name="plan" value="plan"> 
   <param name="buttons" value="on"> 
  </applet> 
  <applet name="plan" archive=" pva.jar " 
code="pviewer.pvplan.class" width="520" height="300"> 
  </applet></div>  

Tab. 5.2-13. The code that is responsible for displaying the virtual tour on the webpage; 
this is a fragment of code of file main3.htm 
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viewers do not require an extra plug-in, however Java must be installed and activated in the 
visitor’s browser. 
 In order to be able to reach as many users as possible (whose computers all are 
configured differently), it is recommended that the author of a virtual tour could offer a Java-
based solution and corresponding plug-in version. It is the best to give the user the option of 
selecting the file size (large or small) that is right for them when visiting the Web site. The 
comparison of viewers used in the project of creating virtual tour is in the following table 
(Tab. 5.2-14). 
 
Functions FSPViewer SPi-V PanoramaVision (Java) 
Viewer type Stand-alone player Plug-in Java based 
Projection 
format 

Cylindrical, 
cubic, spherical 

Cylindrical, 
cubic, spherical 

Cylindrical, spherical 

Zoom Yes Yes Yes 
Hot-spots Yes Yes Yes 
Integration of 
other media 

No Sound (probably in 
SPi-V 2.0), video 

No 

Navigation 
during loading 
time 

No loading time Yes No 

Implementing 
virtual tour 

Writing a code in FSV 
files 

Writing a code in XML 
files 

In editor 

Calculating 
position of hot-
spots 

In image editor + for 
example Ms Excel 

SPi-V Spotter In editor 

Code in XML No Yes Yes 
Support for 
HTML 

No Yes Yes 

User interface No Yes, editable No 
Panoramic 
images 

JPEG, TIFF, FSV all image formats JPEG 

Hardware 
accelerated 

Yes Yes No 

Fullscreen Yes Yes No 
Licensing Free outside Italy branding name 

displayed 
contact with 

SASTAdigital 
Latest version 
used in the 
project  

1.3 [ 28.07.2005] 1.2.14d [29.08.2005] pva.jar [29.08.2005] 

Download www.fsoft.it/panorama/ 
FSPViewer.htm 

www.fieldofview.nl www.sastadigital.com 
[contact with K.Knothe] 

 
 
 
 
 
 
 

Tab. 5.2-14. Comparing three viewers used in the project 
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6. Stereo panoramic images 
 
6.1. Three dimensional perception 

 
 There are three elements of immersive visual environment: 

o complete 360° view, allowing the viewer to look in any desired direction; 
o stereo vision, where each eye gets a different image appropriate to its location in 

space; 
o allow free movement. 

The first point was described in details in the previous pages. Stereo vision and Head 
Mounted Devices (that allow for a free movement of a head) are topics of the next chapter.  
 Stereo panoramas are a new scene to image projection that enables simultaneously 
both: 

o stereo; 
o complete panoramic view. 

No depth information is necessary. Viewers of stereo panoramas have the ability to freely 
view, in stereo, all directions. A stereo pair consists of two images from two different 
viewpoints. The disparity, which is the angular difference in viewing directions of each scene 
point between the two images, is interpreted by the brain as depth (Fig. 6.1-1). 

 
 

 

 
 

Stereo possible in 
viewing direction 

No stereo 
this derection 

Stereo possible in 
viewing direction 

No stereo 
this derection 

No stereo 
this derection 

No stereo 
this derection 

Fig. 6.1-1. Two images are interpreted by the brain as depth [32]. 
 

Fig. 6.1-2. No arrangement of two single-viewpoint images can give stereo in all viewing 
directions. For upward viewing the two cameras should be separated horizontally, and for 

side ways viewing the two cameras should be separated vertically.  
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Fig. 6.2-2. The two viewpoints for these projections are 
always in optimal positions for stereo viewing [34] 

 

 The disparity is a function of the point’s depth and the distance between the eyes 
(baseline). Maximum disparity change, and hence maximum depth separation, is along the 
line in the scene whose points have equal distances from both eyes. No stereo depth 
separation exists for points along the extended baseline. Fig. 6.1-2 shows a conventional 
stereo setting. 
 According to GLUCKMAN  and NAYAR [33], people can perceive depth from stereo 
images if the viewpoints of the two cameras generate horizontal disparity in a specific range. 
Stereo has been obtained in panoramic images by having two viewpoints, one above the other. 
However, since the disparity in this case is vertical, it can only be used for depth calculation, 
and not for viewing by humans eyes which are separated horizontally.  
 
6.2. Methods for generation stereo panoramas 
 
6.2.1. Multiple Viewpoint Projections 
 
 Stereo panoramic imaging uses a special type of multiple viewpoint projections, 
circular projections, where both the left-eye image and he right-eye image share the same 
cylindrical image surface [34]. To enable stereo perception, the left viewpoint and the right 
viewpoint are located on an inner circle (the “viewing circle”) inside the cylindrical image 
surface as shown in Figure 6.2-1. 

 
 

 
 
 
 The viewing direction is on a line 
tangent to the viewing circle. The left-eye 
projection uses the rays on the tangent line in 
the clockwise direction of the circle, as in 
Figure 6.2-1b. The right-eye projection uses 
the rays in the counter clockwise direction as 
in Figure 6.2-1c. Every point on the viewing 
circle defines both a viewpoint and a viewing 
direction of its own. The applicability of 
circular projections to panoramic stereo is 
shown in Figure 6.2-2. From this figure it is 
clear that the two viewpoints associated with 
all viewing directions, using “left-eye” 
projection and the “right-eye” projection, are 
in optimal relative positions for stereo 
viewing for all directions.  

(a) 
Central projection 

(b) 
Left Eye projection 

(c) 
Right Eye projection 

Fig. 6.2-1. Circular projections [34] 
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Fig. 6.2-3. The spiral mirror can be also used in 
generation of stereo panoramas [34] 

 

6.2.2. Stereo panoramas with rotating cameras 
 
 When panoramic images are captures from two different viewpoints, the disparity and 
the stereo perception will degrade as the viewing direction becomes closer to the baseline 
until no stereo will be apparent. Generation of images-based stereo panoramas by rotating a 
stereo head having two cameras was proposed by HUANG [35] and SHUM, SZELISKI [36]. A 
stereo head with two rotated cameras is rotated, and two panoramic mosaics are created from 
two different cameras. 
 
6.2.3. Stereo panoramas with a spiral mirror 
 
 Creating images having circular 
projections using a regular camera and a 
spiral shaped mirror is another method 
of getting stereo panoramas [34]. The 
shape of the spiral mirror can be 
determined for a given optical center of 
the camera o, and a desired viewing 
circle V. The tangent to the mirror at 
every point has equal angles to the 
optical center and to the tangent to the 
circle (Figure 6.2-3). Each ray passing 
through the optical centre will be reflected by this mirror to the tangent to the viewing circle. 
This is true also in reverse: all rays tangent to the circle will be reflected to pass through the 
optical centre. Next method similar to this one is using spiral lens. While not constructed yet 
at the time of writing this diploma thesis, these systems represent the only known possibilities 
to capture real-time movies having the stereo panoramic features. 
 
6.2.4. Panoramic stereo movies 
 
 Stereo panoramic cameras are capable of capturing a dynamic scene. This movie can 
than be projected in a theatre having a stereo projector and cylindrical screen. Each viewer, 
equipped with the appropriate stereo glasses, is able to view any desired direction. A more 
interactive experience can be obtained when an individual viewer is using a head-mounted 
display.  
 
6.2.5. Method of a triangle 
 
 This is a method of compilation a 360° stereoscopic panorama using parts of three 
panoramic images taken from three corners of equilateral triangle. The idea of that method 
was invented by Professor Józef Jachimski of AGH University of Science and Technology in 
2005 for the use in the part of this diploma project executed in Cracow.  
 The main task of creating stereo panoramas was to get a correct viewing while 
spinning 360°. Stereo panoramas were made in two sites in Cracow. One of them was 
Grodzka Street near St. Paul and Peter’s church. The second stereo panorama was generated 
in Nowa Huta (a district of Cracow) at Rose Avenue (Aleja Ró). Those sites were chosen 
because there were no objects very near the position of cameras, and the buildings were far 
enough from the centre of the triangle. “The method of a triangle” is the temporary name of a 
method used in this diploma thesis.  
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Fig. 6.2-4. The scheme of Professor Jachimski’s “method of a triangle”  
to get a stereo panorama 

 

C 

B 

2 
A  C 

1 
A  B 

- d - 

3 
B  C 

4 
B  A 

5 
C  A 

A 

6 
C  B 

Left  
panorama 

Right 
panorama 

A 

C 

B B C C 

B 

A 

C A A B 

1 2 3 4 5 6 Area 

 On each of two sites the equilateral triangle was designed. At Grodzka Street the 
length of the triangle’s side was 1.5m and at Rose Avenue – 2.0m. Three cylindrical 
panoramas were generated on each site, one in every corner of each triangle. A sequence of 
images was taken with digital camera which was rotated about a vertical axis. Then these 
images were stitched to get this cylindrical panorama. This process of stitching images to get 
a panorama is described in chapter 6.3. The space around the triangle is divided into 6 
sections. These sections are presented as ellipses in Fig. 6.2-4. Different colours of ellipses 
and arrows help to understand this method. A, B and C are the positions of taking three 
panoramas. For example, the first section (area) is created using parts of panoramic images 
from positions A and B. The first ellipse and two arrows directed to this ellipse are blue. The 
Area 2 could not be created by using the same positions because there is no stereoscopy along 
the extended baseline A-B. That is why, one need to eliminate position B and use parts of 
panoramas from positions A and C to create a stereoscopic view when viewing in direction of 
Area 2. Area 3 is visible the best in stereo when using parts of panoramas from positions B 
and C. For Area 4 – B and A. This is just the opposite site of panoramas that creates stereo in 
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Fig. 6.2-5. Mirror stereoscope. 

Fig. 6.2-6. Nikon D50 
 

Fig. 6.2-7. The seam in 
end-product panorama at 

Rose Avenue.  
 

Area 1. Area 5 is visible in stereo when using parts of panoramas taken from positions C and 
A. The last Area 6 – from positions C and B.  
 Under the triangle (Fig. 6.2-4) there is a presentation of two colourful stripes. These 
two stripes present two end-product panoramic images (stereo component panoramas) that 
should be generated using three panoramas taken from the triangle corners (A,B and C). 
Every end-product panorama should consist of 6 parts that corresponds to 6 areas around the 
triangle. Then these two panoramas could be viewed in stereo using mirror stereoscope (Fig. 
6.2-5) or anaglyph glasses (after editing for example in 3D Fix). 
 

 

 Photos that were used in my project to create panoramic 
images were taken with the 
author’s digital camera - Nikon 
D50 (Fig. 6.2-6). This camera has 
6.0 million effective pixels 

(3008x2000pixels). A stable tripod 
was from the Department of 
Photogrammetry and Remote Sensing Informatics from AGH 
University of Science and Technology. It was not a tripod with 
special panoramic head.  
 The panorama on the Rose Avenue was taken at 5am 
and at Grodzka Street at 9am. In the morning there was small 
traffic and not a lot of people were passing those places. The 
trick of generation a good perception in whole 360° is that the 
parts of original panoramas were not cut in pre-defined angles 
but they were cut by viewing the image and comparing the 
results. For example panoramas were not cut every 60° (360° 
divided by 6 areas). The angle of cutting was not defined 
before. To get a good stereo perception in whole 360° some 
details were chosen and then the image was cut (for example 
along the edge of the church or through trees). The problem of 
difference of scales was then edited in image editor with Stamp 
Tool in order not to see the difference in the scale. There is an 
example of a mosaic (Fig. 6.2-7) that was created after 
connecting two parts of panoramas that was taken from 
different positions. The difference in scale is visible only in the 
lower part of the image (three stairs), but not in the centre and at 
the top of the image where are windows and branches of tree. 
These stairs were retouched in order not to see an error in stereo 

panorama.  
 At the end of generation of stereo end-product 
panoramas, the result was checked in VSDGL.exe (Mariusz 
Twardowski’s program for displaying images for mirror 
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Fig. 6.3-1: Composing multiple rotated camera views into a panorama. The “x” 
mark indicates the locations of the camera optical and rotational centre. [34] 

 

stereoscope). Individual steps of generation of stereo panoramas are described in the 
following pages. 
 
6.3. Stitching images in PTGui 

 
6.3.1. Stitching images 

 
 A panoramic image is created by composing a series of rotated camera images. This 
sequence of images is taken while rotating a camera about a vertical axis that approximately 
passes through the camera optical centre. Each image in the sequence is then projected onto a 
cylindrical surface whose cross-sectional radius is an initially estimated focal length  
(Fig. 6.3-1). 

 
 

 
 

 
6.3.2. PanoTools – PTGui 
 
 Panorama Tools (PanoTools) consists of several components and is designed to be 
used for the production of cylindrical, spherical and cubic panoramas. As PanoTools is not 
very user-friendly, it is recommended that an add-on program such as PTGui or PTMac is 
used. This software integrates all of the PanoTools functions in a well organized, easy to 
understand graphic interface. PTGui runs on Windows, with a comparable product available 
for the Mac termed PTMac. PTGui could be tested for 30 days for testing and then must be 
registered. Version 4.1 was used in the generation stereo panoramas. The latest version could 
be downloaded from [37].  
 In the following examples, cylindrical panoramas are produced that consists of 7 
individual pictures. The 7 pictures were taken in sequence at an interval of about 50 degrees. 
Creating a panorama using PTGui software requires use of the following editing tabs: Source 
Images, Lens Optimizer, Panorama Settings, Crop, Image Parameters, Control Points, 
Optimizer, Preview and Create Panorama.  
 A presentation of stitching process is carried out on the example of one panorama that 
was taken on Grodzka Street. The first step is to import the individual pictures in the Source 
Images tab (Fig. 6.3-2) by clicking Add button [18]. In the Lens Settings tab, one should select 
a lens type. The software can automatically calculate the corresponding values based on 
horizontal field of view or focal length. Focal length was integrated under EXIF, so all the 
process of choosing a lens type was done automatically. Horizontal field of view is 65.5° and 
focal length is 28.001mm. Setting for the resulting panoramic file is configured in the 
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Fig. 6.3-2: Individual pictures are loaded in the Source Images tab. 
 

Fig. 6.3-3: Individual pictures are positioned in the Image Parameters tab. 
 

Panorama Settings window. Here one can select the desired file format. Projection specifies 
the form of projection; here, the possible settings are Rectilinear (for planar pictures), 
Cylindrical (for cylindrical 360° panoramas) and Equirectangular (for spherical 360° 
panoramas). In this case, Cylindrical projection were chosen. Vertical field of view was 
automatically calculated and is 39.13°.  
 

 
 
 

 Individual pictures can be cut, or cropped as require in the Crop tab. This function is 
helpful when using for example circular fisheye pictures. The arrangement of the individual 
pictures in the panoramic strip is defined in the Image parameters tab (Fig. 6.3-3). 
 

 
 

 
 

 The Control Points tab (Fig. 6.3-4) is used to specify individual points in the 
overlapping area of the individual pictures that are to coincide in the panorama. These points 
should be distributed as equally as possible in the overlapping area. The more control points 
are defined, the greater the fitting accuracy. In this project 7 control points were used in every 
pair. When selecting points, it is advantageous to focus on areas of the picture that are rich in 
contrast. In the editing window, two neighbouring pictures are placed next to each other. The 
stitching points are set using the left mouse button and appear in the table in the lower right 
corner of the window. Once all of the required control points have been defined, the Next or 
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Fig. 6.3-4: In the Control Points tab, stitching points are defined  
in the overlapping area of the individual pictures. 

 

Fig. 6.3-5: The expected result is notified in the Optimizer results window. 
 

Prev button should be pressed to go to the next overlapping area. When all of the points for all 
of the pictures have been set, it is time to click on the Optimizer tab.  
 

 
 
 
 
 

 In Optimizer tab, the previously defined parameters such as focal length, field of view, 
position and distortion of the individual pictures are optimized such that the stitching points 
selected coincide with each other as much as possible. The optimization process is started by 
clicking the Run Optimizer button. Optimizer shows the average distance between the control 
points. The smaller the number, the better the chance of obtaining a good result. After 
optimization has concluded, a message window is displayed that informs you of the expected 
result (Fig. 6.3-5). 
 

 
 
 
 

 The optimization result is very good. It could be better when using a special tripod 
head for recording panoramas. Sometimes when the optimizer does not expect a good result, 
it is recommended to delete the control points with a greater difference and redefine them. 
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Fig. 6.4-2: The “left” end-product panorama at Rose Avenue 
 

Fig. 6.4-3: The right panorama that was created using 3 panoramas  from 3 positions (A,B,C). 
 

Fig. 6.3-6: The “left” end-product panorama at Grodzka Street that was created using 3 
panoramas from 3 positions (A,B,C). 

 from 3 positions (A,B,C). 

Fig. 6.3-7: The “right” end-product panorama at Grodzka Street that was created using 3 
panoramas from 3 positions (A,B,C). 

 

Fig. 6.4-1: The method of 
triangle – three positions A,B 

and C. 

After this one can see a preview of the panoramic picture in the Preview tab. The panorama is 
created in the Create Panorama tab. Clicking the Create Panorama button initiates the final 
stitching process and saves the resulting panoramic image. Three panoramas were taken on 
each place (three on Grodzka Street and three on Rose Avenue). The result of the mosaic 
process is shown in Figures 6.3-6 and 6.3-7. These are two end-product panoramas that were 
generated from three panoramas.  
 

 

 

 

 
6.4. Method of a triangle in practice 
 
 Figure 6.4-1 shows the method that was used to 
generate stereo panoramas. A tripod is in the middle of Rose 
Avenue. A triangle was created on the ground. Three 
panoramas were taken in three positions that are marked as 
A, B and C in Figure 6.4-1. Then parts of these three 
panoramas were used to create two end-product panoramas 
that will be used to viewing for example in mirror 
stereoscope. Figures 6.4-2 and 6.4-3 show the method how 
these parts were cut and how they were stitched in Adobe 
Photoshop. Please refer to Figure 6.2-4 and two colourful 
stripes presented there. Left panorama is created from three 
double parts (Fig. 6.4-2) but right panorama is created from 
two double parts (C and A) and two single parts (B at the 
beginning and at the end of the stripe) – Fig.6.4-3. 

 
 

 

A B C 

A C B B 
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Fig. 6.5-1: Shutter glasses. [38] 
 

Fig. 6.5-2: Head Mounted Displays. [38] 
 

6.5. Viewing stereo panoramas 
 
 There are basically two different types of devices that produce stereo. One of them is 
glasses which just influence the way one sees the image on a standard monitor. For example 
mirror stereoscope (Fig. 6.2-5), anaglyph glasses, shutter glasses (Fig. 6.5-1). None of these 
glasses produces an image. The others are devices which actually produce an image by 
themselves (for example VR-Helmets or Head Mounted Displays (Fig. 6.5-2)).  
 

       

 

 

 In this diploma thesis there will be a presentation of displaying stereo panoramas using 
two mentioned earlier methods (glasses and HMD). At first there will be a presentation of 
mirror stereoscope and anaglyph glasses. Secondly, an implementation of stereo panoramas 
into Head Mounted Device - VFX1, will be presented. 
 According to John T. Bell from University of Michigan, USA [39], there are several 
different methods for generating stereo views:  

o Dual output graphics cards: There are some graphics cards that have multiple monitor 
connections, making it possible to output two separate images simultaneously. One 
example is the Diamond FireGL 3000. With this card it is possible to set the 
resolution to twice a normal setting (for example: 2048 x 768 or 1024 x 1536), which 
will cause half the image to be sent to each video output.  

o Field Sequential Mode: A normal display mode for most monitors and graphics cards 
will refresh the entire screen at a rate of 60 Hz. For field sequential stereo, the image 
is refreshed at 120 Hz, but every other frame is for the left eye, and the alternate 
frames are for the right eye. The user wears a special pair of LCD (Liquid Crystal 
Display) glasses that block the vision of alternate eyes at the same 120 Hz frequency. 
These glasses work by applying an electrical current to LCD panels such that the right 
eye does not see the left eye images and vice versa. This mode requires that both the 
monitor and the video card be capable of 120 Hz refresh frequencies. 

o Over/Under Mode: This mode is similar to the field sequential mode, except that the 
video card issues a 60 Hz signal with the left eye image in the top half of the screen 
and the right eye image in the bottom half of the screen. This video signal is passed 
through a converter box that adds an extra sync signal, such that the monitor receives 
a 120 Hz signal with half the vertical resolution of the signal issued by the graphics 
card. The converter box also issues a signal to LCD shutter glasses, as described 
above, so that each eye only sees the correct view. 

o Line Sequential Mode or Interlaced Mode: In this mode, every other scan line goes to 
one eye, and the remaining lines go to the other eye. 
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Fig. 6.5-3: Screen shot from VSDGL.exe – showing a part of panorama from Grodzka Street. 
 

o Split Screen: In this approach, the left eye image appears on the left half of the screen, 
and the right eye image appears on the right. A mirror stereoscope (Fig. 6.2-5) is used 
for viewing. 

 Those methods were dependent on hardware. Two of them will be presented in the 
following pages. Line Sequential Mode is a method that is used to present three dimensional 
images in a helmet for virtual reality – VFX1 Headgear (see chapter 6.5.3). Split Screen is 
another method (see chapter 6.5.1) that is dependent on hardware. Mirror stereoscope is 
necessary to view in stereo. The stereo perception can also be generated using anaglyph 
glasses (this method is not dependent on hardware). This technique is presented in chapter 
6.5.2 on the example of one stereo panorama that was created at Grodzka Street in Cracow. 

6.5.1. Mirror stereoscope and VSDGL.exe 
 
 As it was mentioned before, glasses influence the way we see an image. They are used 
to watch a standard monitor. For example shutter glasses block the light from the right eye 
while the monitor shows an image for the left eye and vice versa. The monitor has to show 
separate images for the left and right eye at a high rate. In this diploma thesis mirror 
stereoscope and anaglyph glasses were used in viewing stereo panoramas. 
 To see a stereoscopy on the standard monitor, the left image should be displayed on 
the left part of the monitor and the right image should be displayed on the right part of the 
monitor. VSDGL.exe is a program for displaying images in such way. VSDGL.exe is a 
viewer that is based on OpenGL standard and it was created by Mariusz Twardowski from the 
AGH University of Science and Technology in Cracow. The code of this program was a little 
changed to enable viewing long images such as panoramas. Unfortunately, it was not possible 
untill now to change a code in this program that one could spin more than 360°. To get a 
stereo effect in viewing panoramas that was created on Grodzka Street or Ró Alley, one 
needs to change names of files. Left image should be named: panl50.tif and the right one – 
panr50.tif. Then one could run vsdgl.exe and move mirror stereoscope (Fig. 6.2-5) close to the 
monitor. The following view will be visible (Fig. 6.5-3). 
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Fig. 6.5-4: After loading left and right panoramas into 3D PIX – the image is in Interlaced Mode. 
 

Fig. 6.5-5: Specyfying Image Layout in 3D PIX. 
 

 It is advisable to change the speed of mouse movement by pressing “2”. What is more, 
one should also press SHIFT+P to hide the pointer in the middle of each image.  
 
6.5.2. Anaglyph glasses and FSPViewer 
 
 At first, a process of creating an anaglyph images is presented. To do this one need to 
install 3D PIX – Stereoscopic Image Editor. Version 3.4 of this program is used in this 
diploma thesis. This version of 3D PIX is an evaluation copy and it may be used on a single 
computer for a period of 30 days. This program could be found in the Internet [40]. After a 
process of installation one should run this program and firstly open left image and then the 
right one (File-> Open-> Left Image/Right Image). In the main window of this program, one 
could see connected image but in Interlaced Mode or Line Sequential Mode (Fig. 6.5-4) 
because every second line comes from left or right panorama. 
 

 
 

 
 
 
 
 
 
 
 
 
 

 To get an anaglyph panorama, one should save the resulting image. (File-> Save 
Stereoscopic Image…). Then Anaglyph option should be chosen (Fig. 6.5-5). 
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Fig. 6.5-6: Anaglyph panorama created in 3D PIX. 
 

Fig. 6.5-7: Anaglyph glasses are important to watch stereo panorama [38] 
 

 

 After saving an anaglyph panorama (Fig. 6.5-6) on the hard disk, one should watch 
this panorama, running FSPViewer (see chapter 5.2.1). The most important think to get a 
stereoscopic perception while watching this anaglyph panorama is to wear anaglyph glasses 
(Fig. 6.5-7). 

 
 

6.5.3. Head Mounted Display – VFX1 Headgear 
 
Head Mounted Display 
 
 According to Webopedia – encyclopaedia dedicated to computer technology [41] – 
HMD (abbreviation for Head Mounted Display) is a headset used with virtual reality systems. 
An HMD can be a pair of goggles or a full helmet. In front of each eye there is a tiny monitor. 
Because there are two monitors, images appear as three-dimensional. In addition, most HMDs 
include a head tracker so that the system can respond to head movements. For example, if 
you move your head left, the images in the monitors will change to make it seem as if you 
were actually looking at a different part of the virtual reality. 
 This chapter will present how to install this helmet for virtual reality and how to view 
a panoramic image, especially stereo panorama. 
 
VFX1 Headgear 
 
 VFX1 Headgear was designed in 1995 by Forte Technologies. The author owned this 
virtual helmet and tried to display panoramic images at the Institute of Photogrammetry and 
Remote Sensing in Dresden, where an old computer was provided. The old computer was 
necessary because this helmet for VR was designed 10 years ago. VFX1 was tested on 
computer equipped with Pentium II processor and the main board has one free ISA Expansion 
Slot. Video card VGA with 100% VESA standard compliant feature connector was also found 
there. VFX1 works perfectly in DOS but it has many problems while running in Windows. 
Most tests were carried out on system Windows 98 in Dos Mode.  
 Specifications of VFX1 Headgear are presented in Tab.6.5-1. 
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Displays 
Individual lens focus 
3D stereoscopic Smart Visor – 789x230 resolution RGB x 2 
Dual 0.7” colour liquid crystal displays (181,470 pixels) 
256 Colours 
Picture size:  
vertical = 10.6 mm 
horizontal = 14.3 mm 
Optics 
Field of view (FOV) 
vertical = 26.4 degrees 
horizontal = 35.5 degrees 
diagonal = 45.0 degrees 
Virtual Orientation System Head Tracker 
Angular range: 
vertical = +/- 70 degrees 
horizontal = 360 degrees 
Angular resolution: 
vertical = 0.077 degrees 
horizontal = 0.251 degrees 
Three degrees of freedom: 
yaw (azimuth):360 degrees 
pitch (elevation):+/- 70 degrees 
roll (tilt):+/- 70 degrees 
VFX1 Interface Protocol (VIP) Card 
Interfaces with standard VGA feature connector 26-pin ribbon cable  
60Hz Refresh Rate (60 times per second) - up to 1 kHz refresh rate possible  
Utilises ACCESS.bus Connectivity Standard 
Connections 
Single 26-pin D-connector (High resolution) containing video, audio and VOS head 
tracking sensor cable  
Connects to VFX1 Interface Protocol (VIP) card  
ACCESS.bus host connector (Phone Jack Connector)  
VIP interfaces with standard VGA feature connector  
2 cables from stereo sound card to VIP card (for headphones and microphone)  
VIP card requires 8 bit PC ISA slot 
Video 
Dual active matrix colour LCDs  
Works with existing Standard VGA applications 
Requirements 
IBM PC or compatible 386, 486, Pentium +  
Video card (VGA minimum) with 100% VESA standard compliant feature connector (ISA, 
VLB, PCI)  
Free ISA Expansion Slot  
One free base port: 260, 280, 2A0, 2C0  
One free IRQ: 5, 7, 10, 11, 12, 15  
Stereo-capable soundcard (for audio) 

 
 
 

Tab. 6.5-1: Specifications of VFX1 Headgear [42] 
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Quick Install 
 

o Open the computer system and insert the VIP Card (Fig. 6.5-9) into free ISA slot 
o Attach the free end of the VESA feature connector cable to system’s VESA connector 
o Close the computer system. 
 

 
 

 
 

o Make final connections – connect VIP Card and CyberPuck (red ellipse in  
Figure 6.5-8b) with the helmet. 

o Download the latest driver vfx1_216.exe from [43] 
o Install VFX1 Headgear software 
o Setup VFX1 Headgear Interface Protocol Card (select I/O address and IRQ) 
o Adjust VFX1 Headgear optics 
o Test VFX1 Headgear by running setvfx1.exe 

  

                               (a)      (b) 
Fig. 6.5-8: Testing VFX1 at the Institute of Photogrammetry and Remote Sensing 

 at the Dresden University of Technology 

Fig. 6.5-9: VIP Card with VESA Feature Connector (red ellipse). 
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Fig. 6.5-10: The Digital Signal 
Processor controller that is 

inside VFX1 

 A few important parts of this helmet for VR will 
be presented. Those parts (Fig. 6.5-12) are important 
while viewing panoramas, especially stereo panoramas.  

o VFX1 Headgear Smart Vision – allows the VR 
user to use the PC interactively without removing 
the headset. 

o 3D Stereoscopic Imaging – a pair of colour LCDs 
where each creates 789 x 230-pixel image. Each 
eye sees different images in stereo mode, but both 
eyes work as a team to provide depth. It provides 
true realistic stereo imaging.  

o 3D VOS Head Tracker – this system tracks your 
head’s move. The Digital Signal Processor 
controller provides accurate movement which 
may be seen in Figure 6.5-10 and is marked with 
red ellipse. The VOS Head Tracker provides roll, 
pitch and yaw (Fig. 6.5-11) for precise VR 
orientation.  

o Forte CyberPuck – the 2-axis CyberPuck can be 
used instead of mouse or joystick. It has 3 
programmable buttons. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 

Fig. 6.5-11: VFX1’s axes that are use by VOS Head Tracker. [44] 
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 The VFX1 Headgear was calibrated at the factory, but may require in-field calibration 
due to environmental factors. The VFX1 uses the local magnetic field in the vicinity of the 
helmet as a calibration reference. Items that can cause changes of this field could be iron 
made objects. This leads to sporadic tracking and dead spots. This problem occurred in the 
VFX1 which was tested in this diploma thesis. Probably the controller (Fig. 6.5-10) was 
slightly damaged. The reason why this problem occurs could be the fact that the helmet could 
have stayed to long in strong magnetic field. However it works in some range of horizontal 
and vertical movement. It works well in range of 150° (horizontally). The calibration process 
does not help to solve this problem. What is more, the producer of this helmet does not 
produce VR helmet any more and it changed the name to Interactive Imaging Systems so 
there are no updates of software for VFX1. Although the system of head tracking does not 
work properly, it is worth to display panoramic images, especially the three dimensional ones. 
The following pages show how to display them in VFX1. The system of recognizing the 
head’s movement works well only in the range of 150° and this is enough to view a part 
panoramic image. The stereo panorama could be displayed also on another VFX1, not only 
the one that was tested in the Institute in Dresden. 
 
 
 
 

Fig. 6.5-12: Major components of VFX1 Headgear system [45] 
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Displaying panoramic images in VFX1 
 
 For displaying panoramic images in VFX1 the program VRWDOS.EXE is used. This 
program needs file DOS4GW.EXE and it runs in DOS or in Windows in Dos Mode. The 
author of this program received this program from Dr. William Lane Craig from USA.  
 To view panoramic image in the VFX1 one needs to do the following steps: 

o Copy this viewer (from the DVD enclosed to this diploma thesis) – VRWDOS.EXE to 
the same folder where software for VFX1 is installed (for example: c:\vfx1\ ) 

o Run VFX1.COM to activate the helmet 
o In image editor change the size of the panorama that is going to be viewed. This 

viewer accepts panoramic images with the following conditions: 
�  The width must be a multiple of 4 and greater than 1280. 
�  The height must be greater than 480. 
�  Reduce number of colours to 256 by choosing Indexed Color in image editor 

(Image->Mode->Indexed Color) 
�  Save as Bitmap (BMP – Windows - 8 bit) 

o An example file 51.BMP has a resolution of 2040x648. 
o Make batch file with the following line (Tab. 6.5-2): 
 
 
 
 
 
o Put the helmet on your head (Fig. 6.5-13) and also take CyberPuck to your hand. 
o The software (VRWDOS.EXE) operates as follows: 

�  The HMD allows the user to look left/right and up/down. 
�  The CyberPuck (handheld controller) can be used to Zoom in/out.  

�  Fine Zoom: pitching forward/backward. 
�  Course Zoom: button 2/3. 

o Press ESC to exit. 
 

 
 
 
 

 

vwrdos.exe 51.bmp -M 

Tab. 6.5-2: The batch file (51.bat) that runs a panorama number 51 in VFX1 

Tab. 6.5-13: The spherical rectangle is currently visible in VFX1,  
while the shaded outside area is pre-fetched [45] 
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Tab. 6.5-14: The part of resulting 
panorama (grodzka.bmp) in Line 

Sequential Mode. 

Displaying stereo panoramic images in VFX1 
 
 To display stereo panoramic image in VFX1 
one needs to transform panoramas to Line Sequential 
Mode. To do this one should run program 3DPix that was 
mentioned in chapter 6.5.2. To make stereo panorama for 
VFX1 a few steps need to be done: 

o Change a size of two end-product panoramas 
(those mosaic panoramas which was created from 
three positions for example at Grodzka Street in 
Cracow – they are presented in Figures 6.3-6 and 
6.3-7) to 4444x500 pixels. 

o Change them to Indexed Colour (Image->Mode-
>Indexed Color). 

o Save as 8bit Windows Bitmap (BMP) 
o Import those two bitmaps to program 3DPix. First 

“left” panorama and then “right” panorama.  
o Save the resulting image as a new panorama 

(grodzka.bmp) (Fig. 6.5-14) and choose the 
option Interlaced during the saving process 
(please refer to Fig. 6.5-5 but choose not 
Anaglyph but Interlaced). 

o Displaying panorama in VFX1 was mentioned on 
a previous page (change only the batch file to 
grodzka.bat with the following line of code  
(Tab. 6.5-3): 

 
 
 
 
 
 

o Put the helmet on your head and experience 
stereo panorama. 

o Press ESC to exit the viewer. 
 
 The author of the diploma did not find a solution of implementation a virtual tour 
into VFX1 Headgear. To do this advanced programming in ANSI C is necessary to create 
panoramic images together with hot-spot information.  
 
 
 
 
 
 
 
 
 
 
 

vfx1.com +t 
vwrdos.exe grodzka.bmp -M 

Tab. 6.5-3: The batch file (grodzka.bat) that runs 
stereo panorama in VFX1. 
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7. Conclusions 
 
 
 In this diploma thesis there were two parts discussed. The first part was about creating, 
editing and displaying the virtual tour of the Dresden University of Technology campus. Fifty 
three panoramic images were taken using digital panoramic camera Eyescan MM1. It was 
provided by KST GmbH from Dresden. The author used it many times during his 9-months 
stay in Dresden. The stations for taking panoramic images were situated in the places from 
which one could see the neighbouring stations and having this it was possible to design a 
virtual tour. 
 According to the topic of panoramic images the following conclusions were drawn: 

o Editing panoramic images in image editor takes much more time than the process of 
taking them. 

o Because of the high cost of more than 20,000€ of digital panoramic cameras this 
method of taking panoramic images is not so popular as stitching pictures to get a 
panorama. 

o Panoramas taken with digital panoramic camera does not require stitching, only the 
seam edge needs to be edited. 

o The fastest method of taking spherical panorama is to take only two hemispherical 
images (a conventional camera and fisheye lens). A little slower method is using 
digital panoramic camera with fisheye lens. 

o Stitching images is the most time consuming procedure in creation of a panorama. 
o Having a full control on the process of creating virtual tours, the knowledge of XML 

and HTML is advisable. 
o The best viewer for the virtual tour of the TU Dresden campus is SPi-V viewer that 

was born in November 2004 and it is still developed. 
o SPi-V was also the best viewer for on-line version of this virtual tour. 
o For slow Internet connection Java-based viewer is recommended. 

  
 The second part of this diploma thesis was about stereo panoramic images. A method 
of a triangle was carried out at two places in Cracow in Poland. After that two end-product 
panoramic images were generated in order to be viewed in stereo. Three different methods of 
viewing three dimensional panoramas were presented. The most interesting one was using an 
old but still working helmet for virtual reality. There are a few conclusions about three 
dimensional panoramas. 

o Panoramas that were later cut into parts and used for stereo viewing were made from 
the sequence of images and stitched in program PTGui. 

o Panoramas were created on a conventional tripod. A special tripod head for panoramic 
images were not used. Average distances between control points after optimization in 
PTGui were about 4 pixels. The resulting panoramas were evaluated as very good. 

o Method of a triangle was used for places where there are no objects close to three 
camera positions. 

o VSDGL.exe – in this viewer for mirror stereoscope one can not spin more than 360°, 
because this program was not designed for panoramic images. 

o Anaglyph panoramas could be viewed using a stand-alone viewer and the viewing 
does not depend on hardware. 

o Head tracking system in the VFX1 was slightly damaged. Despite this fact that a 
panoramic images could be viewed in the helmet. The range of viewing is limited to 
about 150° horizontally. 

o VFX1 works only with old computers and use old technologies (such as VESA, ISA). 
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o VFX1 could not display more than 256 colours (8 bit). 
o A special VIP card for VFX1 works on ISA standard that does not exist in modern 

main boards.  
o Working well in DOS and problems with Windows makes this helmet reluctant for 

more improvements. 
 
 Panoramic images were successfully implemented into VFX1 Headgear. The 
implementation of the virtual tour was not successful. The perfect virtual tour implemented 
into the virtual helmet should be like this: 

o True color (24 bit) stereo viewing  
o Full working head tracking that is not dependent on iron objects around the user 
o Consists of high resolution spherical panoramic images 
o Short loading time for panoramas 
o Handheld device (like CyberPuck for VFX1) should be used to navigate between 

panoramic images and for zooming areas of interests. 
o 3D music should be played in headphones. 

 
 Interactive panoramas are provided for complete documentation of areas. When 
spherical panoramas are used, every physical detail in the camera’s environment can be 
recorded. It would be the best to have a virtual tour that was created not only from panoramic 
images but also from real data that was achieved by laser scanner. Comparing the first and the 
second Panoramic Photogrammetry Workshop in Dresden (2004) [47] and in Berlin (2005) 
[48], a trend of fusion of terrestrial laser scanner data with imagery from digital panoramic 
cameras is indicated. Next solution that could be used in a perfect virtual tour is using GPS to 
determine the exact positioning data of a particular photographic site. This solution could lead 
to mapping systems with a lot of graphics, sound, video and of course GPS data.  
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  01_night_panorama (chapter 3.6) 
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  03_corrections_Panotools (chapter 4.2) 
   Correction for Panorama Tools: horizontal, vertical, vertical2 
  04_VT_FSPViewer (chapter 5.2.1) 
   excel values – xls file to determine values for control files 
   FSPViewer – two versions of FSPViewer 
   virtual_tour  – run !!!.bat (contains 23 panoramas and control files) 
  05_VT_SPi-V (chapter 5.2.2) 
   SPi-V_spotter_Windows 
   SPiV_viewer 
   virtual tour – high resolution (run !!!.bat) 
   virtual tour – low resolution (run !!!.bat) 
  06_VT_Java (chapter 5.2.3) 
   all the project of Java based virtual tour – run !!!.bat 
  07_PTGUI (chapter 6.3) 
   read readme.txt file before installation of PTGui and Panorama Tools 
  08_3D_panoramas (chapter 6.5) 
   Grodzka_Street 
    Anaglyph – run !!!.bat 
    Three panoramas 
    Two_end_product_panoramas – run vsdgl.exe 
   Rose_Avenue 
    Anaglyph – run !!!.bat 
    Three_panoramas 
    Two_end_product_panoramas – run vsdgl.exe 
  09_VSDGL (chapter 6.5) 
   vsdgl.exe and 2 example panoramas 
  10_3DPIX (chapter 6.5) 
   pixinste.zip – unzip and install 
  11_VFX1 (chapter 6.5.3) 
   files – contains drivers, SDK, FAQ, Manual etc. 
   no_stereo_panorama – run 51.bat 
   stereo_panorama – run grodzka.bat 
  12_WWW_PANOTOUR 
   Webpage with this project [status: 18.09.2005] 
 
DDVVDD--PPAANNOO22: contains original panoramic images taken with Eyescan MM1 (panoramas  
1-27). DDVVDD--PPAANNOO33 – panoramas 28-44. DDVVDD--PPAANNOO44 – panoramas 45-53. 
 


